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1Using the Autodesk OnSite 
View COM API

The Autodesk® OnSite View Component Object Model 

(COM) Application Programming Interface (API) extends 

the capabilities of Autodesk OnSite View by supporting 

custom functionality through add-ins. This chapter 

describes how to start writing applications with the COM 

API.

In this chapter

■ About this document 
and API

■ Typical applications

■ Useful terms

■ Developing and 
loading an add-in

■ Writing and 
debugging add-in 
code

■ Implementing 
custom menus

■ Drawings and layers

■ Working with 
markups

■ Responding to 
selections

■ Controlling views

■ Coordinate system

■ Converting files 
manually
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About This Document

This document is intended for programmers who want to add functionality 
to Autodesk OnSite View, and provides details about:

■ Using the COM API

■ Using the Inter-Application API

Opening This Document

When you install either Autodesk OnSite View, the Setup program installs 
this guide on your hard drive and creates Start-menu shortcuts. To open this 
document from the Windows desktop, choose Start ➤ Programs ➤ Autodesk 
OnSite View 2.3 ➤ Autodesk OnSite View Developer’s Guide.pdf.

Autodesk Developer Network

Autodesk Developer Network (ADN) is a developer-support organization that 
provides its members with services, including:

■ A quarterly CD containing Autodesk products, documentation, and 
sample code

■ Technical training

■ Direct, comprehensive technical support

■ Marketing support

■ Developer consulting services

■ Access to private newsgroups

ADN membership is open to experienced professional software developers 
who develop products and services that interface or integrate with Autodesk 
products. For more information about membership requirements and fees, 
visit the Autodesk developers web site at http://www.autodesk.com/devel-
opers.

About the Autodesk OnSite View COM API

The Autodesk OnSite View COM API is a set of components, each of which 
supports one or more interfaces. By using the methods exposed by these 
interfaces, add-in developers can determine and modify the state of the 
application. An add-in is a COM component that implements a specific COM 
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interface. Autodesk OnSite View uses this interface to retrieve add-in state 
information and notify the add-in of application events. The COM API does 
not have any dialog boxes or other graphical user interface elements.

You use the COM API by creating a dynamic link library (DLL) that contains 
one or more of your add-in components. A single add-in component can 
support multiple menu commands and event notifications. When a user 
clicks an add-in menu item, Autodesk OnSite View notifies your COM 
component of the event. The event handler implements your custom func-
tionality.

By using the COM API, you can extend Autodesk OnSite View’s functionality 
by:

■ Capturing or simulating user interaction
■ Controlling the UI view
■ Working with markup primitives
■ Making simple edits to markup objects

Capturing User Interaction

Autodesk OnSite View notifies add-ins when a user adds or changes markup 
information. You can write routines that handle these events and implement 
custom functionality. When a user adds a markup object, you might want to 
record information about that object in a database, for example.

Controlling the User Interface View

To guide users through your application in an automated or semi-automated 
fashion, you can use the COM API to access user interface view attributes, 
such as the centerpoint and zoom setting. With this information, you can 
create programs that activate layers and pan or zoom to the desired view.

Working with Markup Primitives

If you develop GIS applications, you may have a global positioning system 
(GPS), or some other location-determining system that supplies coordinate 
information to the mobile device. In these situations, you can use the COM 
API to add, change, and move spatial primitives on a drawing’s markup layer.
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Editing Markups

By using the COM API, you can create programs that alter markups as the 
user works with them. You can write code that changes the text of a note 
symbol or the appearance of a custom symbol, for example.

Typical Applications

This section lists application areas for the API and briefly describes examples 
of applications used in these areas.

Location capture

A geographic survey application uses manual methods to capture location 
information—such as range, bearing, or offsets—and displays it on the map. 
A GPS application uses automated methods to capture locations, and 
displays them on the map to support fleet-tracking and other location-based 
services.

Database connectivity

A form-based application queries a database and links the results back to a 
map, or users select multiple graphical objects and retrieve associated data-
base rows.

Multimedia capture

An add-in handles information other than text, such as sound, image, and 
video.
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Useful Terms and Acronyms

This document uses the following terms and acronyms:

Term or Acronym Description

ATL (Active Template 
Library)

A set of template-based C++ classes that simplifies the 
process of developing a COM application or add-in.

CLSID (Class identifier) A universally unique identifier (UUID) for your add-in. 
You add this identifier to the system registry so that 
Autodesk OnSite View can identify and load the add-in.

COM (Component Object 
Model)

A software architecture that facilitates the 
interoperation of multiple-vendor software 
components.

DWG (Drawing format file) The standard file format for saving vector graphics from 
within AutoCAD.

DXF (Drawing Interchange 
Format)

An ASCII or binary file format of an AutoCAD drawing 
file used for exporting AutoCAD drawings to other 
applications or for importing drawings from other 
applications. 

IDE (Integrated 
Development 
Environment)

A development platform for creating and testing 
applications.

MFC (Microsoft 

Foundation Classes)
A framework upon which you can build a Windows 
application.

MWF (Map Window File) The Autodesk MapGuide native file format.

OSD (OnSite Drawing) The Autodesk OnSite View native file format.

OSM (OnSite Markup) The Autodesk OnSite View native markup file format.

RML (Redline Markup 
Language)

A file format derived from XML for communicating 
markup information from Autodesk OnSite View and 
Autodesk Volo View to Autodesk AutoCAD.
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Developing an Add-In

The development process for an add-in consists of creating a COM project 
and adding a COM component to it. You implement the IOSAddIn interface 
as a COM component in C++, compile it into a DLL, and register it with the 
operating-system registry. You can register multiple add-ins. The develop-
ment environment for an Autodesk OnSite View add-in consists of the 
following components: 

■ Microsoft eMbedded Visual Tools, which includes Microsoft eMbedded 
Visual C++

■ Microsoft ActiveSync

Note The examples in this chapter use Microsoft eMbedded Visual Tools 3.0 and 
Microsoft ActiveSync 3.1.

Creating a COM Project

This section describes how to create a COM project.

To create a COM project

1 Launch Microsoft eMbedded Visual C++.

2 Choose File ➤ New.

The New dialog box appears.

WCE The Windows CE operating system.

WCS (World Coordinate 
System)

Measurement units in real world coordinates, such as 
miles or feet.

WKT string (Well-Known-
Text string)

Text formatted as specified by the Open GIS 
Consortium (OGC). 

Term or Acronym Description
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3 Select WCE ATL COM AppWizard.

4 Enter a project name and location. Choose a different name from the one 
that you want to use for the add-in component itself.

5 Select the options for the CPU types.

6 Click OK.

The wizard displays the next page.

7 Click MFC Support if your application requires it. The sample applications 
in this chapter use Microsoft Foundation Classes (MFC).

8 Click Finish.

The New Project Information screen appears.

9 Click OK.

Adding a COM Component

This section describes how to add a COM component to the project. This 
component is a framework for your add-in. Subsequent sections describe 
how to implement and register the component.

To add a COM component

1 Choose Insert ➤ New ATL Object.

The ATL Object Wizard page appears.
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2 Under Category, select Objects.

3 Under Objects, select Simple Object.

4 Click Next.

The ATL Object Wizard Properties page appears

5 On the Names tab, enter a Short Name (SampleAddIn, for example). Accept 
the defaults for the rest of the settings. The short name specifies the name 
of your add-in.

6 Click OK.

Implementing the Interface

You transform the COM component (SampleAddIn) that you created in the 
previous procedure into an Autodesk OnSite View add-in by implementing 
the IOSAddIn interface. This section describes how to implement this inter-
face. Your COM component also can implement other interfaces.
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To implement the IOSAddIn interface

1 Locate the new COM object in the ClassView.

2 Right-click the COM object. Make sure to right-click the object, 
CSampleAddIn in this example, and not the interface, ISampleAddIn.

3 Choose Implement Interface from the shortcut menu.

A warning message appears.

4 Ignore the warning message and click OK.

The Browse Type Libraries dialog box appears.

5 Click Browse.

6 Navigate to the OnSite folder and open the file OSObjects.tlb.

7 Select IOSAddIn.

8 Click OK.

The IDE creates stubs for all the methods.

9 To view the methods, expand your COM object in the Class View.
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Subsequent sections explain how to use these methods to build your custom 
add-in.

This completes the framework for your add-in, but you still must register the 
add-in with the operating-system registry.

Registering an Add-In

Each add-in has a unique class identifier (CLSID) that you register with the 
operating-system registry. The IDE creates this identifier for you when you 
create a new COM component.

Autodesk OnSite View checks the following registry path to find add-ins that 
it should load:

\HKEY_CURRENT_USER\Software\Autodesk\OSAddIns

Each add-in has a subkey that is identified by its CLSID:

\HKEY_CURRENT_USER\Software\Autodesk\OSAddIns\CLSID

The values for the CLSID subkeys are:

■ (default)—The add-in’s user-readable name, such as OnSite GPS Extension

■ description—The add-in’s description, such as A sample GPS add-in

Microsoft eMbedded Visual C++ creates a registry script for 
HKEY_CLASSES_ROOT (HKCR). You use the procedures in this section to 
extend this script to configure HKEY_CURRENT_USER (HKCU). You don’t 
need to use Registry Editor to perform these procedures.

To register your add-in

1 In the File View, expand the Resource Files tree.
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2 Double-click the .rgs file for your project.

The registration script appears. The following listing shows a typical 
HKEY_CLASSES_ROOT (HKCR) registration script contained in the .rgs 
file.

HKCR
{

OnSiteAddIns.SampleAddIn.1 = s 'SampleAddIn Class'
{

CLSID = s '{03AB6F81-B679-4FFA-8687-ADD56D3C8327}'
}
OnSiteAddIns.SampleAddIn = s 'SampleAddIn Class'
{

CLSID = s '{03AB6F81-B679-4FFA-8687-ADD56D3C8327}'
CurVer = s 'OnSiteAddIns.SampleAddIn.1'

}
NoRemove CLSID
{

ForceRemove {03AB6F81-B679-4FFA-8687-ADD56D3C8327} = s
     'SampleAddIn Class'

{
ProgID = s 'OnSiteAddIns.SampleAddIn.1'
VersionIndependentProgID = s 'OnSiteAddIns.SampleAddIn'
ForceRemove 'Programmable'
InprocServer32 = s '%MODULE%'
{

val ThreadingModel = s 'Apartment'
}
'TypeLib' = s '{9102F36C-CA9B-4139-A258-7DCED6A17D21}'

}
}

}

3 Note the location of the CLSID number, which this sample HKCR script 
shows in bold text, enclosed in curly brackets after ForceRemove.

4 Copy the following code for HKCU, and paste it to the end of the HKCR 
script automatically generated for your add-in.

HKCU
{

NoRemove Software
{

NoRemove Autodesk
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{
NoRemove OSAddIns
{

ForceRemove {<CLSID>} = s 
'My add-in'
{

val Description = s 'A sample add-in for new users.'
}

}
}

}
}

5 Copy the CLSID number, which is unique to your add-in (not the number 
shown in the sample script), from the location that step 3 instructed you 
to note. Paste the CLSID number into the HKCU script within the curly 
brackets after ForceRemove, replacing <CLSID>.

Warning The CLSID number is unique to your add-in. Do not copy the num-
ber shown in the sample HKCR script in step 2.

6 Choose File ➤ Save.

Testing the Add-in Framework

Before developing your application, test the framework that you developed 
in this section. This test verifies the integrity of the add-in before you develop 
your custom functionality.

You have many ways to test the framework. The procedures in this section 
describe one way, which opens a message box when your add-in loads. This 
procedure assumes that you included MFC functionality when you created 
the project.

To test the add-in framework

1 Insert the following test code into the C++ source file SampleAddIn.cpp. For 
this example, you implement the onLoaded method as follows: 

HRESULTCSampleAddIn::onLoaded(IOSApplication * pApplication, 
long hWnd)
{

HWND m_hWnd;
m_hWnd=HWND(hWnd);
MessageBox(m_hWnd,_T("The test add-in loaded.")

,_T("Message Box Caption"), MB_OK);
return S_OK;

}
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2 Delete the stub code for onLoaded from the header file SampleAddIn.h. Do 
not delete the function prototype for onLoaded from the header file.

3 Choose Build ➤ Rebuild All. 

The build is downloaded to the handheld device and registered with the 
operating system and Autodesk OnSite View.

4 On the mobile device, launch Autodesk OnSite View.

The message “The test add-in loaded.” appears.

Loading an Add-In

Autodesk OnSite View dynamically loads each add-in at runtime and 
performs these tasks during the startup process:

■ Loads the application.

■ Checks the registry of the mobile device for Autodesk OnSite View add-
ins. These are add-ins registered under the following key: 
HKEY_CURRENT_USER\Software\Autodesk\OSAddIns

■ Initializes the COM environment for each registered add-in.

■ Calls IOSAddIn::onLoading.

■ Retrieves custom menu items from the add-in and constructs a menu.

■ Calls the IOSAddIn::onLoaded method to allow the add-in to initialize.

If more than one add-in exists, each is created and initialized in turn. After 
the add-in is loaded, it waits for Autodesk OnSite View to notify it of an 
event. When an event occurs, Autodesk OnSite View calls the corresponding 
method on the add-in interface.

The add-in component implements the methods of the IOSAddIn interface, 
and can make callbacks to Autodesk OnSite View in response to the calls 
made to these methods. Some of the methods have parameters that pass 
object interfaces to the add-in component. When a user creates an object, for 
example, onMarkupObjectAdd passes the new object as a parameter to the 
add-in.

Writing Add-In Code

Earlier, this document described how to create the framework for your 
custom add-in. The framework is a functional add-in, but all the methods are 
stubs that do not implement any functionality. To develop your custom 
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application, you replace the stubs with your own code, by using methods 
that vary by application. This section explains the process of writing the add-
in code.

Autodesk OnSite View communicates with your add-in by calling IOSAddIn 
methods when significant events occur. IOSAddIn methods then interact 
with application objects by calling their methods and accessing their 
attributes.

The IOSAddIn interface also supports custom menus, so you can add a menu 
item to Autodesk OnSite View menus. The menu item provides access to your 
custom functionality.

Accessing Objects

Your add-in receives pointers to object interfaces when events occur. The 
interface you get varies by event, and can range from the application object’s 
primary interface to an IOSMarkupObject interface. You can always work 
with this object directly through the passed interface, but often you need to 
examine or change other objects in the object model. This means that you 
need to navigate up or down the object model to get an interface to the 
desired object. To see the object hierarchy, see “The Autodesk OnSite View 
COM API Object Model” on page 44.

One strategy for navigating the model is to start from the top and work 
down. The top of the model is the application object, which you can access 
through the interface passed by IOSAddIn’s onLoaded event during the 
initialization process. It’s generally a good idea to save this interface as a 
member variable for use by other event handlers.

To navigate the entire drawing hierarchy

1 Get a pointer to the application interface. The onLoaded event passes this 
pointer to the add-in.

2 Get the drawing attribute by using the method OSApplication::getDraw-
ing.

3 Work your way down the hierarchy by using the methods that get child 
objects. Each object contains an attribute that points to its child, if one 
exists.

4 Implement the desired behavior.

5 Release system resources to preserve memory integrity.

Alternatively, you can start with an object lower in the hierarchy and work 
up. Each object contains pointers to its parent object.
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Using Attributes

The COM API does not implement formal COM properties. However, some 
objects have variables that are more like properties than methods. For 
simplicity, this document calls these variables attributes.

You access most attributes by using get and set methods, but read-only 
attributes have only a get method. The VisibleState attribute of the 
OSDrawingLayer object, for example, has these get and set methods:

HRESULT getVisibleState([out] VARIANT_BOOL *pVisibleState)

HRESULT setVisibleState([in] VARIANT_BOOL newVisibleState)

Handling HRESULT

Autodesk OnSite View methods return the standard COM HRESULT return 
value. This return value indicates success or failure, and provides details 
about the failure. HRESULT is a 32-bit value, which is organized as a bitmap. 

Bits Information

31 to 30 Success or failure and severity.

29 Customer code flag.

28 Reserved.

27 to 16 The facility generating the error.

15 to 0 Detailed error information.
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You can interpret this bitmap directly, or you can use standard HRESULT 
values. The following table lists frequently used standard values:

Frequently, client applications test for only success or failure. For this 
purpose, COM provides the following macros:

■ SUCCEEDED
■ FAILED

These macros simply test the most significant bit of HRESULT and return true 
or false. The following code fragment shows how to test for a method failure:

HRESULT Meaning

NOERROR Same as S_OK.

S_OK The method executed successfully.

S_FALSEa

a. Not used by Autodesk OnSite View.

Success, but return value FALSE. User only on 
OSDrawingLayer::getMin/MaxDisplayRange.

E_ABORTa Operation aborted.

E_ACCESSDENIEDa General access denied error.

E_HANDLEa Invalid handle.

E_INVALIDARG One or more arguments are invalid.

E_NOINTERFACEa No such interface supported.

E_NOTIMPL Method not implemented. The stub programs return 
this result.

E_OUTOFMEMORY Memory allocation failure.

E_POINTER Invalid pointer.

E_UNEXPECTED Catastrophic failure.

E_FAIL The method failed in an unspecified manner.
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HRESULT hr;
IOSDrawingLayerCollection * pDrawingLayers = NULL;
hr = pDrawing->getDrawingLayers(&pDrawingLayers);

// Test for failure.
if (FAILED(hr))

return hr;
// Succeeded.
pDrawingLayers->Release();
return S_OK;

On failure, this example returns the error code to the calling program. It’s 
good coding practice to always test for success or failure. For brevity, the 
examples in this book omit this test.

Note If a failure occurs, remember to release system resources.

Programming Guidelines

These guidelines help you write reliable code and avoid common problems.

Shutdown Guidelines

Autodesk OnSite View closing is a step-wise process. First, the application 
notifies each add-in that the application is preparing to shut down. This noti-
fication is IOSAddin’s onShutdown event. Then, each add-in returns either 
VARIANT_TRUE to override the shutdown, or VARIANT_FALSE if it’s ready to 
stop, in the pStopShutdown argument. A return value of E_NOTIMPL also 
permits the shutdown. Because individual add-ins do not know if all other 
add-ins are ready to shut down, this event should never cause your add-in to 
shut down. Use the OSAddIn’s onUnloading event to actually clean up and 
shut down.

CPU Usage Guidelines

Autodesk OnSite View operates on a single execution thread. When it triggers 
an event, it passes complete control of that thread to the add-in. Therefore, 
the add-in should minimize CPU usage when it is called. From the users 
point of view, excessive CPU usage seems to lock the application. In those 
cases where a CPU-intensive task must be executed, such as a database query, 
the add-in should notify the user to wait.

Pointer Usage Guidelines

Managing the lifetime of pointers is a responsibility that add-ins and 
Autodesk OnSite View share. You manage pointers by using the AddRef and 
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Release methods of the IUnknown interface. When you want to keep a local 
copy of an interface pointer, use AddRef. When you finish using an interface 
pointer, call Release to inform the object that it has one less client. 

Your add-in is responsible for releasing the following COM pointers:

■ References retrieved through a collection
■ References obtained with a method beginning with get or create

Don’t release pointers received through an event notification method; 
Autodesk OnSite View owns those pointers. Don’t free the pointer you obtain 
from onMarkupGroupAdd(IOSMarkupGroup * pMarkupGroup), for 
example.

Also, avoid holding pointers to interfaces that you plan to use later. It’s better 
to start from the application pointer and work your way down the hierarchy.

Collection Usage Guidelines

Collections identify members by an item number. Item numbers start at zero 
and end at one less than the number of items in the collection; there are no 
gaps. This is important to remember when deleting items from a collection 
by using a loop, because the item numbers change as you delete items. There-
fore, delete items from a collection from the top down, starting with the 
highest item number.

Debugging Add-in Code

Microsoft eMbedded Visual C++, downloads code to the handheld device 
each time you compile. After each download, you can test your add-in by 
launching Autodesk OnSite View on the mobile device. However, if you want 
to debug the add-in by using Integrated Development Environment (IDE) 
tools, you need to set up your development environment, which includes the 
mobile device, desktop computer, and the IDE.

Setting Up the Mobile Device

The mobile device requires no special setup for debugging. The debugger 
requires only the Autodesk OnSite View executable and your custom add-in 
DLL.

The default location for the OnSiteView executable is:

\Program Files\OnSite View\OnSiteView.exe
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The location and file name of the add-in is your choice. For the examples in 
this section, the location and name of the add-in file is:

\Program Files\myAddIns\OnSiteViewAddIns.dll

To use the sample configuration described in this section, you need to create 
the folder myAddIns. The IDE downloads the DLL to that folder after it 
rebuilds the add-in.

Setting Up the Desktop Computer

On your desktop computer, create a directory structure for holding 
OnSiteView executables for the platform(s) that you plan to support. The 
following diagram shows one possible configuration.

The installation program creates the \Program Files\Autodesk\OnSite View 2.3 
folder, where it saves the type library, OSObjects.tlb. All platform types use the 
same type library. The other folders hold executables for specific platform 
types. Because all executables have the same name, save them in separate 
folders. Of course, you need folders for only the platform types you plan to 
support.

The installation program does not copy the executable file to the desktop 
computer. To debug your add-in, copy these files from each mobile device to 
the corresponding folder on your desktop computer.

Even though the mobile device executables do not contain debug informa-
tion, you can still use them to debug your add-in.

To copy files from the mobile device

1 Open your eMbedded C++ workspace.

2 Click Tools ➤ Remote File Viewer.

The Windows CE Remote File Viewer appears.

SH3

SH4

ARM

OnSiteView.exe (SH3 version)

OnSiteView.exe (SH4 version)

OnSiteView.exe (ARM version)

Program Files

Autodesk

OnSite View 2.3 OSObjects.tlb

MIPS OnSiteView.exe (MIPS version)
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3 If necessary, set up a connection to a mobile device.

4 Navigate to the file OnSiteView.exe.

5 Click File ➤ Import File.

6 In the Import File dialog box, specify the desktop folder that corresponds 
to the processor type of the mobile device. For example, for a MIPS pro-
cessor specify:

C:\Autodesk\OnSite View 2.3\MIPS

7 Repeat steps 3 through 6 for other mobile devices, as necessary.

Setting Up the IDE

You change the project settings to match your development environment as 
described in this section.

To initialize the IDE

1 Open eMbedded C++.

2 Click Project ➤ Settings, and click the Debug tab.

The Debug tab of the Project Settings dialog box appears.
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3 From the Settings For drop-down list, select the target platform (debug 
version).

4 Enter the local executable path and file name. This is the platform-specific 
OnSiteView executable stored on the desktop. For example:

C:\Program Files\Autodesk\OnSite View 2.3\MIPS\OnSiteView.exe

5 Enter the remote executable path and file name. This is the OnSiteView 
executable on the mobile device. For example:

\Program Files\OnSite View\OnSiteView.exe

6 Enter a download directory. The default is \Windows, but it’s better to ded-
icate a folder to your add-ins, for example, \Program Files\myAddIns.

7 Repeat steps 4 through 6 for each platform you support. When you are fin-
ished, click OK.

8 Click Build ➤ Set Active Configuration.

The Set Active Project Configuration dialog box appears.
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9 Select the debug option for your platform, and click OK.

Setting Breakpoints

Once you’ve finished setting up the development environment, you can use 
the debugger normally. This section describes breakpoint usage.

To use a breakpoint

1 Set a breakpoint in your code.

2 Press F7 to rebuild the project.

3 Press F5 to start debugging. 

The program executes to your breakpoint and halts.

Note You may receive a warning that the source does not contain debug 
information. Ignore the warning and click OK.

Implementing Custom Menus

An add-in can add one or more custom menu items to the Autodesk OnSite 
View application, but it can add menu items only once, during application 
startup. You cannot dynamically change menu items later.

The following methods of the IOSAddIn interface support custom menus:

■ getFirstMenuItem
■ getNextMenuItem
■ isMenuItemChecked
■ isMenuItemEnabled
■ onMenuItemSelected 

The get methods add your custom menu items to the application, the is 
methods control how they are displayed, and the on method indicates when 
a user chooses a menu.

Adding Menu Items

You add menu items to your application by implementing the 
getFirstMenuItem and getNextMenuItem methods. Autodesk OnSite View 
calls getFirstMenuItem once and getNextMenuItem repeatedly until one of 
these methods returns -1 for the menu item ID. Custom menu items appear 
under the Tools menu, as shown in this illustration.
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To add menu items

1 Implement the getFirstMenuItem method, specifying the menu item text 
and a menu item ID. If you don’t want to add a menu item, simply return 
a menu item ID of -1 and skip the next step.

2 Implement the getNextMenuItem method. If you want to add another 
menu item, specify the menu item text and a unique menu item ID. When 
you are finished adding menu items, return -1 for the menu item ID.

3 Remove stub code for these methods from the header file.

The following example adds one custom menu item, called Custom Menu 
Item, to the Tools menu.

/////////////////////////////////////////////////////////////////
// getFirstMenuItem event

HRESULT CSampleAddIn::getFirstMenuItem(BSTR * pMenuItemName, SHORT 
* pMenuID)
{

CComBSTR bstrMenuName;
short sMenuId;

// Initialize test parameters and states for a custom menu item.
sMenuId = 0;
bstrMenuName = "Custom Menu Item";
bChecked = false;
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bEnabled = true;

// Test for null pointers.
if (NULL == pMenuItemName)

return E_POINTER;
if (NULL == pMenuID)

return E_POINTER;

// Return the custom menu item id and text.
*pMenuID = sMenuId;
bstrMenuName.CopyTo(pMenuItemName);
return S_OK;

}

//////////////////////////////////////////////////////////////////
// getNextMenuItem event

HRESULT CSampleAddIn::getNextMenuItem(BSTR * pMenuItemName, SHORT * 
pMenuID)
{

// Test for null pointers.
if (NULL == pMenuItemName)

return E_POINTER;
if (NULL == pMenuID)

return E_POINTER;

// Indicate that there are no more custom menus.
*pMenuID = -1;
return S_OK;

}

Controlling Menu Items

You control the behavior and appearance of menu items with the methods 
isMenuItemChecked and isMenuItemEnabled. Autodesk OnSite View calls 
these methods for each custom menu item, each time the user clicks the 
Tools menu.

To control custom menu items

1 Implement the method isMenuItemEnabled, which enables or disables 
each menu item. Disabled menu items appear in shaded text in the user 
interface and do not respond to user inputs.

2 Optionally, implement the method isMenuItemChecked, which places or 
removes a check mark next to each menu item. Check marks can help dis-
tinguish which menu item is in effect.

3 Remove stub code for these methods from the header file, as necessary.

The following example enables a custom menu item and places a check mark 
next to it. This example has only one custom menu item, so the methods do 
not need to check the ID parameter.
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/////////////////////////////////////////////////////////////////
// isMenuItemEnabled method

HRESULT CSampleAddIn::isMenuItemEnabled(SHORT MenuID, VARIANT_BOOL 
* pEnabled)
{

// Test for a null pointer.
if (NULL == pEnabled)

return E_POINTER;

// Determine menu status and return the corresponding value.
if (bEnabled)
{

*pEnabled = VARIANT_TRUE;
}
else
{

*pEnabled = VARIANT_FALSE;
}
return S_OK;

}

/////////////////////////////////////////////////////////////////
// isMenuItemChecked method

HRESULT CSampleAddIn::isMenuItemChecked(SHORT MenuID, VARIANT_BOOL 
* pChecked)
{

// Test for a null pointer.
if (NULL == pChecked)

return E_POINTER;

// Determine menu status and return the corresponding value.
if (bChecked)
{

*pChecked = VARIANT_TRUE;
}
else
{

*pChecked = VARIANT_FALSE;
}
return S_OK;

}

Responding to Menu Activation 

Autodesk OnSite View calls onMenuItemSelected when a user taps one of the 
custom menu items.

To respond to user inputs

1 Implement the method onMenuItemSelected to check for menu items 
that are selected. 
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2 Remove stub code for this method from the header file.

The following example toggles the checked state for the menu item each time 
the user clicks the menu item.

/////////////////////////////////////////////////////////////////
// onMenuItemSelected method

HRESULT CSampleAddIn::onMenuItemSelected(SHORT MenuID)
{

// Check to see which menu item was selected. 
// Only menu 0 is possible here.
switch (MenuID)
{
case 0: 

toggle(); // toggle the selected state
break;

default:
break;  // Do nothing

}
return S_OK;

}

/////////////////////////////////////////////////////////////////
// toggle method

HRESULT CSampleAddIn::toggle()
{

if (bChecked == true) bChecked = false;
else bChecked = true;
return S_OK;

} 

Working with Drawings and Layers

Autodesk OnSite View creates an empty drawing object when it starts. This 
drawing object contains a single empty markup layer, to which a user can add 
markup groups. Users typically open a background drawing that provides a 
context for their particular application. This background drawing could be a 
map, architectural drawing, or another Autodesk OnSite View drawing (OSD 
file). In addition, users can open a previously stored Autodesk OnSite View 
markup (OSM file) that enhances or clarifies the drawing.

Opening a Drawing

You can automate the process of opening a drawing, and customize its 
presentation, by using the API. To open a drawing, write code that navigates 
to the IOSDrawing interface and invokes its openFile method. You can open 
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a drawing from one of the events, such as onLoaded or onMenuItemSelected. 
Remember to release system resources before exiting to avoid memory leaks.

The following example opens the sample drawing (Sample.osd) included with 
Autodesk OnSite View. This code assumes that your project supports 
Microsoft Foundation Classes, and that the code previously captured a 
pointer to the application interface. You also have to call the method open-
File from one of the IOSAddIn events; if you add only this code, the add-in 
does nothing.

HRESULT CSampleAddIn::open()
{

HRESULT hr;
// Get a pointer to the drawing object’s interface.
IOSDrawing * pDrawing = NULL;
hr = m_pApplication->getDrawing(&pDrawing);
if (FAILED(hr)) 

{
AfxMessageBox(_T("Get drawing FAILED"));
return hr;

}
// Open a drawing file.
BSTR bstrFileName;
bstrFileName = SysAllocString(_T("\\My Documents\\Sample.OSD"));
hr = pDrawing->openFile(bstrFileName);
// Release resources.
SysFreeString(bstrFileName);
pDrawing->Release();
if (FAILED(hr))

{
AfxMessageBox(_T("File open FAILED"));
return hr;

}
return S_OK;

}

The user interface displays the sample drawing:
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The sample drawing is an architectural view of a two-story building. By 
default, all drawing layers are displayed.

Hiding Drawing Layers

After the sample drawing is open, you can hide layers that the user does not 
need. The drawing layers are predefined attributes that were specified when 
the drawing was created. To hide layers, write code that navigates to the 
IOSDrawingLayer interfaces and hides the desired layers by setting the 
VisibleState attribute to VARIANT_FALSE. You can invoke such a procedure 
from one of the events, such as onLoaded or onMenuItemSelected.

The following example locates and hides the drawing layers of the sample 
drawing that show the first floor. This example assumes that the sample 
drawing is already open, and that you have called this method from an event 
handler.

HRESULT CSampleAddIn::layer()
{
// Get a pointer to the drawing interface.

IOSDrawing * pDrawing = NULL;
m_pApplication->getDrawing(&pDrawing);

// Get the Drawing Layers; then release the drawing.
IOSDrawingLayerCollection * pDrawingLayers = NULL;
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pDrawing->getDrawingLayers(&pDrawingLayers);

IOSDrawingLayer * pDrawingLayer = NULL;
BSTR bstrLayerName;
CString cstrLayerName;
long iDrawingLayerIndex = 0, pNumLayers = 0;
int i;

// Iterate through each layer and hide the 1st floor layers.
pDrawingLayers->getNumObjects(&pNumLayers);
for (i=1; i<=pNumLayers; i++)
{

pDrawingLayers->item(iDrawingLayerIndex, &pDrawingLayer);
pDrawingLayer->getName(&bstrLayerName);
cstrLayerName = bstrLayerName;

//Hide the first floor features.
if (cstrLayerName.Left(1) == _T("1"))

pDrawingLayer->setVisibleState(VARIANT_FALSE);

//Free resources.
pDrawingLayer->Release();
SysFreeString(bstrLayerName);

// Next drawing layer
++iDrawingLayerIndex; 

}
pDrawing->refresh();

pDrawing->Release();
pDrawingLayers->Release();

return S_OK;
}

When you run the code in this example, only the second floor is visible, and 
when you open the Options dialog box, you see which layers the code makes 
invisible, as shown in the following illustration.
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Checking Visibility

Drawing layers are not visible to the user when they are outside the current 
view or are hidden intentionally. In some cases, drawing layers may not be 
visible simply because the drawing must be refreshed. You can check for visi-
bility by using the VisibleState attribute of the drawing layer. This attribute 
is VARIANT_TRUE when the layer is visible.

Working with Markups

A drawing has a single markup layer that contains all the markup objects. A 
markup object is one of the following types:

■ osSymbol—A small graphic or icon
■ osPolyline—A multi-sided graphic, such as a rectangle
■ osBezier—A smooth, curved line with Bézier controls
■ osEllipse—A standard ellipse
■ osNote—A note icon that contains markup text
■ osLeader—An annotated callout, usually to another object
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Each markup type has its own set of attributes and methods. The symbol, 
polyline, note, and leader objects have primitive methods that facilitate 
changing their position or appearance.

Autodesk OnSite View provides a set of standard symbols that includes 
arrows, triangles, circles, and squares. You also can add custom symbols to 
your add-in. To add custom symbols to the application, place a Windows 
bitmap of the symbol in \Program Files\OnSite View\Symbols.

Adding a Standard Symbol to the Markup

The following example adds a yellow triangle symbol to the markup layer.

HRESULT CSampleAddIn::primitive()
{

// Get a pointer to the drawing object.
IOSDrawing * pDrawing = NULL;
m_pApplication->getDrawing(&pDrawing);

// Get the Markup Layer.
IOSMarkupLayer * pMarkupLayer = NULL;
pDrawing->getMarkupLayer(&pMarkupLayer);

// Add a markup group to the markup collection.
IOSMarkupGroup * pMarkupGroup = NULL;
pMarkupLayer->createMarkupGroup(&pMarkupGroup);
pMarkupLayer->Release();
pMarkupLayer = NULL;

//Add a markup object of type symbol.
IOSMarkupObject * pMarkupObject = NULL;
pMarkupGroup->createMarkupObject(osSymbol, &pMarkupObject);
pMarkupGroup->Release();
pMarkupGroup = NULL;

// Create a point for the symbol.
IOSPoint * pPointSymbolVertex = NULL;
m_pApplication->createPoint(&pPointSymbolVertex);
pPointSymbolVertex->setX(-100);
pPointSymbolVertex->setY(100);

// Set the symbol primitive.
BSTR bstrSymbolFileName = (_T("Triangle_yellow_fill"));
pMarkupObject->setSymbolPrimitive(pPointSymbolVertex, 

bstrSymbolFileName);
pDrawing->refresh();

// Release resources.
pDrawing->Release();
pMarkupObject->Release();
pPointSymbolVertex->Release();
SysFreeString(bstrSymbolFileName);
return S_OK;



32 | Chapter 1 Using the Autodesk OnSite View COM API

}

When you run the code in this example, the triangle symbol appears in the 
drawing at the specified point. 

Working with the Active Markup Group

Autodesk OnSite View organizes markups into groups. The markup layer 
contains a collection of markup groups, each of which contain a collection 
of markup objects. The markup group that currently is undergoing changes 
is called the active markup group. The active group is not necessarily the same 
as the selected group.

You can respond to changes of active group status by implementing the 
following IOSAddIn methods:

■ onMarkupGroupActive
■ onMarkupGroupInactive

You can view or change the active markup group with the 
ActiveMarkupGroup attribute of the markup layer. To add markups to the 
active group, you can read the ActiveMarkupGroup attribute and then add 
markups to it.
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Tracking Markup Changes

Markup groups maintain information about who authored and revised the 
group, as well as its current status. This information appears in the Markup 
Properties dialog box of the user interface.

Autodesk OnSite View sets the Author and RevisedBy attributes to the name 
of the Autodesk OnSite View user when the markup group was created or 
modified. This user is the one displayed in the User Name field of the 
Drawing tab in the Options dialog box. By default, the Autodesk OnSite View 
user is the same as the one displayed in the Owner Attributes dialog box in 
the Control Panel folder. To track changes from the COM API, read the 
Author or RevisedBy attributes of the desired markup group.

You can use the markup group Status attribute to track the progress of incor-
porating a markup group into the source drawing. The Status attribute is 
read/write and has one of the following states:

■ osPending
■ osApproved 
■ osIncorporated
■ osRejected

The initial status of a new markup group is osPending. You subsequently can 
update this status to osApproved or osIncorporated as markups are approved 
and subsequently incorporated, or osRejected if the markups are rejected.

Responding to Selections

Autodesk OnSite View notifies the add-in when a user either selects different 
objects or taps and holds the stylus on the drawing or markup object.

Changing Selections

When a user changes the selection of drawing or markup objects, the system 
calls onSelectionChanged. This method does not identify the object that 
changed because the selection status of several items may have changed. The 
selection could change from five items to none with a single mouse click, for 
example. To discover what changed, traverse the object hierarchy and check 
the selection status of each object.
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Responding to Tap and Hold Operations

Autodesk OnSite View triggers an event when a user taps and holds the stylus 
on the drawing or markup object. You respond to tap and hold operations by 
implementing the following methods:

■ onDrawingObjectTapAndHold
■ onMarkupObjectTapAndHold

Both methods supply a pointer to the object, either an IOSDrawing or 
IOSMarkupObject. A drawing may have a Link attribute that contains a 
hyperlink to a Web site.

Identifying Objects

Some form-based applications store information in a database and need to 
match objects on the screen with records in the database. The add-in needs 
to notify an application when a user selects or touches an object in the 
Autodesk OnSite View user interface.

Autodesk OnSite View identifies objects with a key. To identify an object in 
the user interface, search the application hierarchy for each markup object 
and check its key attribute. To receive notification when an object is selected, 
implement the onSelected method, which can search the application hier-
archy for the selected object.

Controlling Views

The Autodesk OnSite View user interface includes controls for adjusting the 
drawing view. Users can pan across the drawing and zoom in or out. You can 
achieve the same degree of control from the API. 

The following attributes determine how the drawing appears:

■ ViewX and ViewY
■ CenterX and CenterY
■ Scale

The following diagram shows the relationship between the view and center 
attributes.
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The ViewX and ViewY attributes describe how much of the drawing currently 
is displayed in the user interface. The CenterX and CenterY attributes define 
the point on the drawing that is centered in the display. These attributes are 
relative to a reference point on the drawing, which was defined when the 
drawing was created originally.

The Scale attribute defines the scale factor currently displayed, expressed as 
1:scale. If units are inches, 1:10 means one inch of the display represents 10 
inches in the drawing, for example. Decreasing the scale factor zooms in and 
increasing it zooms out. The valid range of the scale factor varies by drawing 
layer. To check the valid ranges, view the MaxDisplayRange and 
MinDisplayRange attributes of the desired drawing layer. The 
MaxDisplayRange displays the entire layer and the MinDisplayRange 
displays the greatest detail.

The view and scale attributes are not independent. They both control how 
much of the drawing appears, and increasing one of these attributes increases 
the other. Doubling the scale factor zooms out and doubles both view 
attributes, for example.

Panning

An add-in can pan the drawing horizontally or vertically by simply changing 
the CenterX and CenterY attributes, respectively. To pan the drawing relative 
to the current position, get the current center attributes, apply the change, 
and set the new values. Moving the centerpoint to the left pans the display 
to the right.

The following example shows how to pan a drawing right by 100 units.

HRESULT CSampleAddIn::pan()
{

// Get a pointer to the drawing object.
IOSDrawing * pDrawing = NULL;
m_pApplication->getDrawing(&pDrawing);

ViewX

ViewY
CenterY

CenterXReference

User Interface
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// Pan right
double pCenterX;
pDrawing->getCenterX(&pCenterX);
pCenterX -= 100;
pDrawing->setCenterX(pCenterX);
pDrawing->refresh();

pDrawing->Release();
return S_OK;

}

Zooming

An add-in can zoom to the desired location or object by using one of the 
zoom methods:

■ zoomExtent
■ zoomScale
■ zoomSelected

These methods simplify the process of changing display attributes when 
zooming. The method zoomScale facilitates zooming to a new centerpoint 
because it changes the center and scale attributes by using a single method. 
If you want to zoom only around the current centerpoint, you can simply 
change the Scale attribute. By using zoomExtent and zoomSelected, you can 
zoom to an object without knowing the actual centerpoint or scale values.

The following example zooms the display to the extent that includes all the 
user-selected items.

HRESULT CSampleAddIn::zoom()
{

// Get a pointer to the drawing object.
IOSDrawing * pDrawing = NULL;
hr = m_pApplication->getDrawing(&pDrawing);

// Zoom to the current selection.
pDrawing->zoomSelected();
pDrawing->refresh();

pDrawing->Release();
return S_OK;

}

Refreshing

Autodesk OnSite View normally refreshes the display whenever a user 
changes the drawing or view. This assures that Autodesk OnSite View 
responds in an intuitive manner to user actions and accurately represents the 
underlying objects and settings in the display. You can alter this refresh 
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behavior from your add-in, however, by changing the state of the AutoRe-
fresh attribute of the drawing interface. 

If you disable AutoRefresh, the display is not refreshed when you invoke 
methods that change the drawing. You disable AutoRefresh to inhibit auto-
matic refreshes while adding a series of markups to the drawing, for example.

Because AutoRefresh controls the refresh behavior for both users and add-ins, 
you generally want to restore its value to VARIANT_TRUE when an event 
handler returns. Otherwise, the display does not respond normally to user-
initiated changes.

Autodesk OnSite View always refreshes the display when the following 
events occur, regardless of the state of the AutoRefresh attribute:

■ onDrawingLoaded
■ onMarkupLoaded
■ onViewChanging

Because these events always refresh the display, they inhibit execution of the 
refresh method. If you attempt to invoke the refresh method from these 
event handlers, it returns E_FAIL.

For other event handlers, the AutoRefresh attribute controls the refresh 
behavior of the following methods.

Interface Method

IOSDrawing setCenterX
setCenterY
setViewScale
setViewX
setViewY
zoomExtent
zoomScale
zoomSelected

IOSDrawingObject setSelectedState
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You manually can update the display by invoking the refresh method of the 
drawing interface. To control the refresh operation manually, set AutoRefresh 
to VARIANT_FALSE and invoke the refresh method when necessary. Don’t 
assume that the AutoRefresh state is unchanged on subsequent invocations. 
Other add-ins can change its state.

About the Coordinate System

The coordinate system for an OSD drawing is a simple Cartesian grid.

Understanding Units of Measurement

The units of measurement and the origin of the coordinate system are 
defined when the OSD file is created. They correspond to the drawing units 
and origin of the original file, and your add-in cannot change them. 
Autodesk OnSite View reports location as X and Y distances from the origin, 
which may be offset to the east or north.

The OSD file can specify measurements by using a generic drawing unit, 
which Autodesk OnSite View must map to real world measurement units. It 
does so by prompting the user for a unit conversion factor, which represents 

IOSMarkupGroup removeAllObjects
removeMarkupObject
setSelectedState

IOSMarkupLayer setActiveMarkupGroup
removeAllGroups
removeMarkupGroup

IOSMarkupObject setSelectedState
setLeaderPrimitive
setNotePrimitive
setPolylinePrimitive
setSymbolPrimitive

Interface Method
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the number of drawing units that correspond to one meter. The following 
standard unit conversions apply.

To determine the current value, read the UnitConversionFactor attribute of 
the drawing object. You can use this value to convert the units your add-in 
uses to the World Coordinate System (WCS) units for the original drawing.

To convert your units to WCS units

1 Convert your units to meters.

2 Multiply the number of meters by the unit conversion factor.

Suppose that your add-in uses centimeters and the original drawing uses 
inches. The unit conversion factor for a drawing in inches is 39.37. To place 
a point at X=10 cm and Y = 10 cm, convert the coordinates from centimeters 
to meters. With 100 cm per meter, this yields X = 0.1 m and Y = 0.1 m. Then 
multiply each coordinate by the unit conversion factor, which yields 3.937 
inches for both coordinates.

Parsing the Projection String

Autodesk OnSite View drawings (OSD) contain information about how the 
source map (MWF) was projected onto the coordinate system. The projection 
type is defined by the person who creates the map, usually in Autodesk 
MapGuide® Author. Users can view the projection for a map, if one exists, in 
the File Properties dialog box. Add-ins retrieve this information by reading 
the Projection attribute of the drawing interface, which contains an Open 
GIS Consortium (OGC) Well-known Text (WKT) string. This string provides 
a standard representation for coordinate system information.

Autodesk OnSite View supports two of the three OGC coordinate systems:

■ Geographic—latitude-longitude position

Source drawing units Unit conversion factor, in units per meter

Inches 39.37

Feet 3.28

Centimeters 100

Meters 1
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■ Projected—two-dimensional (X,Y) position

The type of system and spatial details are encoded in the WKT string, which 
contains keywords and values in a nested structure that varies by system 
type. The following information is typically provided:

■ The origin of the drawing on the earth.

■ The units the drawing uses. One drawing unit = 1 foot, for example.

■ The reference datum. WGS84 and NAD27, for example.

■ The projection used to transform ellipsoidal coordinates into planar Car-
tesian coordinates. UTM-10N, for example.

As with all maps, measurements of angles, distance, and location are 
distorted according to the properties of the projected coordinate system. The 
accuracy of angles, distances between points, and point locations vary by 
reference datum and projection. The location of the map on the earth 
depends on the origin and other parameters of the projected coordinate 
system. The parameters vary from one system to another.

Autodesk OnSite View does not use parameters such as datum or projection 
when calculating measurements. This information is still important to the 
user of a map, however, because it helps them determine whether the infor-
mation is reliable and accurate of the information. For a GPS application, for 
example, you need the projection information to translate geographic coor-
dinates into drawing coordinates.

The following WKT string shows an example of a geographic projection:

PROJCS["NAD_1983_UTM_Zone_10N", 
GEOGCS["GCS_North_American_1983",

DATUM["D_North_American_1983",SPHEROID["GRS_1980",6378137,
298.257222101]],

PRIMEM["Greenwich",0], UNIT["Degree",0.0174532925199433]],
PROJECTION["Transverse_Mercator"],
PARAMETER["False_Easting", 500000.0],
PARAMETER["False_Northing",0.0],
PARAMETER["Central_Meridian",-123.0],
PARAMETER["Scale_Factor",0.9996],
PARAMETER["Latitude_of_Origin",0.0],
UNIT["Meter",1.0]]

For more information, see http://www.opengis.org. Refer to OpenGIS Simple 
Features Specification for OLE/COM for information about this product.
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Converting Files Manually

This section describes how to use the command-line on the desktop PC to 
convert files manually. An Autodesk OnSite View installation includes a 
command-line utility named OSVConvert that performs the following tasks 
on the PC desktop:

■ Converts DWG and DXF files to OSD format
■ Converts OSM files to RML format

OSVConvert does not use ActiveSync. You can convert a batch of files by 
using a single OSVConvert command.

Using OSVConvert

By default, OSVConvert (OSVConvert.exe) is located in \Program Files\
Autodesk\OnSite View 2.3\, which you can add to your path. Use the 
following syntax to enter conversion commands at a command prompt 
(choose Start ➤ Programs ➤ Accessories ➤ Command Prompt):

> OSVConvert [/O] [/Q] <inputfile1> [<inputfile2>...]

/O

Causes the utility to overwrite existing files without asking for confirmation.

/Q

Suppresses informational messages during file conversion.

<inputfileN>

Names the file(s) to convert. Separate multiple filenames with spaces. 
Surround a filename that contains spaces with quotes.

If you omit the /O parameter, OSVConvert asks you confirm that you want 
to overwrite files with the same name as the input file.

If you omit the /Q parameter, OSVConvert displays informational messages 
as it converts each file. For example:

Overwriting 'C:\My Documents\DRAWINGS\colorwh.osd'... done.

Overwriting 'C:\My Documents\DRAWINGS\COWLING4.osd'... done.

Converting 'C:\My Documents\DRAWINGS\COWLING4MDT.osd'... done.
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Required Files

If OSVConvert cannot access the line types, AutoLISP code, and shapes 
included in the DWG, it cannot correctly convert the DWG to OSD format. 
You must place all files associated with the DWG, such as LIN, LSP, and SHX 
files, in the directory along with the DWG to be converted.

OSVConvert Examples

The following example shows the command to convert DWGs to OSD 
format:

> OSVConvert co*.dwg

The example assumes the files are in your working directory and have a base 
file name beginning with “co”. As shown here, you can use the asterisk (*) 
wildcard character with OSVConvert to convert all files with names begin-
ning with “co”. If you use the asterisk wildcard and /Q is omitted, 
OSVConvert displays the actual name of each file as it is converted.

The following example shows the command to convert Warehouse.dwg to 
OSD format:

> OSVConvert C:\Warehouse.dwg

The following example shows the command to convert multiple DWGs with 
a single command:

> OSVConvert C:\Floor*.dwg "D:\Kansas City\PlazaMap.dwg"

Use quotation marks to specify a file name or path that contains spaces, such 
as: 

“D:\Kansas City\PlazaMap.dwg”

OSVConvert supports the UNC naming convention.
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2The Autodesk OnSite View 
COM API Object Reference

This chapter describes the object model, interfaces, 

attributes, methods, and events of the Autodesk OnSite 

View COM API. Attributes, methods, and events are 

organized by interface, and interfaces are described in 

alphabetical order.

In this chapter

■ The Autodesk OnSite 
View COM API object 
model

■ Enumerated data 
types

■ Descriptions of 
objects in the COM 
API hierarchy
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The Autodesk OnSite View COM API Object 
Model

The following diagram shows the object model and COM interfaces of the 
COM API.
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The following table briefly describes the COM API objects. You access the 
attributes and methods of these objects through their interfaces. A complete 
description of the attributes, methods, and events of these objects follows the 
table for the rest of the chapter.

Objects  Description

OSApplication The root object of the Autodesk OnSite View 2 API 
from which all other objects are derived.

OSAddIn The user-implemented object that extends Autodesk 
OnSite View by implementing its IOSAddIn interface.

OSDrawing The drawing and its base attributes.

OSDrawingLayer A layer of a drawing that displays a subset of the 
drawing features.

OSDrawingLayerCollection The collection of all drawing layers.

OSDrawingObject A feature on the drawing layer.

OSDrawingObjectCollection A collection of drawing features.

OSExtent An object that describes the size of a drawing feature 
or group of features.

OSIntegerCollection A collection of integer data.

OSMarkupGroup A group of markup features.

OSMarkupGroupCollection A collection of markup groups.

OSMarkupLayer The markup layer of the drawing.

OSMarkupObject A drawing feature in a markup group.
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Enumerated Data Types

The following table lists enumerated data types defined by the COM API.

OSMarkupObjectCollection A collection of drawing features.

OSPoint A single point, usually an attribute of a drawing 
feature.

OSPointCollection A collection of points, usually associated with a 
drawing feature.

Name Description Constant =Value

OSMarkupObjectType Types of markup objects. osSymbol
osPolyline
osBezier
osEllipse
osNote
osLeader

OSMarkupGroupStatus Types of markup group 
status.

osPending
osApproved
osIncorporated
osRejected

Objects (continued) Description (continued)
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IOSApplication Interface

The IOSApplication interface is the root of the COM API hierarchy. By using 
the application interface, you can navigate to the interface of any object in 
the hierarchy. By using this interface, you also create integer or point collec-
tions for markup primitives. 

IOSApplication Attribute

The application interface has one attribute as described by the following 
table.

IOSApplication Drawing Attribute

A pointer to the interface of a single drawing object that Autodesk OnSite 
View creates when the application starts. Autodesk OnSite View always has 
one, but never more than one drawing object.

HRESULT getDrawing([out] IOSDrawing **ppDrawing)

Parameters

[out] ppDrawing—The active drawing

IOSApplication 
Attribute

Description Access

Drawing An attribute that represents the active drawing. Read only
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IOSApplication Methods

The following table summarizes the IOSApplication methods and detailed 
descriptions follow the table.

IOSApplication::createIntegerCollection

Creates and returns a collection of integers.

HRESULT createIntegerCollection([out] IOSIntegerCollection 
**ppIntegerCollection)

Parameters

[out] ppIntegerCollection—An IOSIntegerCollection interface

Description

This method supports objects that use a collection of integers.

IOSApplication::createPoint

Creates and returns a point.

HRESULT createPoint([out] IOSPoint **ppPoint)

Parameters

[out] ppPoint—An IOSPoint interface

Description

A point defines a location on the drawing. A single point can define the loca-
tion of a markup primitive, and a collection of points can define a polyline. 

IOSApplication Method Description

createIntegerCollection Creates a collection of integers.

createPoint Creates a single point.

createPointCollection Creates a collection of points.
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To define a polyline markup, you create a point collection. Then, you call this 
method to create points to add to the collection. 

See Also

IOSApplication::createPointCollection on page 49

IOSApplication::createPointCollection

Creates and returns an empty point collection.

HRESULT createPointCollection([out] IOSPointCollection 
**ppPointCollection)

Parameters

[out] ppPointCollection—The new point collection

Description

Use a collection of points to define the vertices of markup polyline primi-
tives. Initially, the collection contains no points.

See Also

IOSApplication::createPoint on page 48
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IOSAddIn Interface

You use the IOSAddIn interface to add your own functionality to Autodesk 
OnSite View. The IOSAddIn interface includes all event notifications and 
methods to support menus. You are responsible for implementing the 
methods of the IOSAddIn interface. 

IOSAddIn Methods and Events

The following table summarizes the IOSAddIn methods.

The following table summarizes the IOSAddIn events and a detailed list of 
methods and events follows the table.

IOSAddIn Methods Description

getCopyright Gets the copyright information that appears in the About 
box.

getFirstMenuItem Gets the first add-in menu item to add to the application.

getNextMenuItem Gets the next add-in menu item to add to the application.

isMenuItemChecked Determines whether to display an add-in menu item as 
checked or unchecked.

isMenuItemEnabled Determines whether to display an add-in menu item as 
enabled or disabled.

IOSAddIn Events Action That Triggers the Event

onActivate Autodesk OnSite View activation status changed.

onAppKillFocus Autodesk OnSite View lost the focus.

onAppSetFocus Autodesk OnSite View got the focus.

onBeginShutdown Autodesk OnSite View is beginning the shutdown 
process.
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onDrawingLoaded Autodesk OnSite View loaded an OSD file.

onDrawingObject
TapAndHold

A user performed a tap-and-hold action on a drawing 
object.

onDrawingUnloaded Autodesk OnSite View finished unloading an OSD file.

onDrawingUnloading Autodesk OnSite View began unloading an OSD file.

onHibernate The mobile device asked this application to hibernate.

onLoaded Autodesk OnSite View finished loading the add-in.

onLoading Autodesk OnSite View started loading the add-in.

onMarkupGroupActive A markup group became active.

onMarkupGroupAdd A user or an add-in added a markup group.

onMarkupGroupInactive A markup group became inactive.

onMarkupGroupModify A user or an add-in modified a markup group.

onMarkupGroup
Removing

A user or an add-in removed a markup group.

onMarkupLoaded Autodesk OnSite View finished loading an OSM file.

onMarkupLoading Autodesk OnSite View started loading an OSM file.

onMarkupObjectAdd A user or an add-in added a markup object.

onMarkupObjectModify A user or an add-in modified a markup object.

onMarkupObject
Removing

A user or an add-in removed a markup object.

onMarkupObjectTapAnd
Hold

A user or an add-in performed a tap-and-hold action on a 
markup object.

IOSAddIn Events Action That Triggers the Event (continued)



52 | Chapter 2 The Autodesk OnSite View COM API Object Reference

IOSAddIn::getCopyright

Gets the copyright information that appears in the About dialog box. 

HRESULT getCopyright([out] BSTR *pCopyright)

Parameters

[out] pCopyright—The copyright text to add to the About dialog box of 
Autodesk OnSite View

Description

By using this method, you can add your third-party copyright information 
to the About dialog box.

See Also

IOSAddIn::getNextMenuItem on page 53

IOSAddIn::getFirstMenuItem

Gets the first custom menu item to add to the application. 

HRESULT getFirstMenuItem([out] BSTR *pMenuItemName, [out] short 

onMarkupSaved Autodesk OnSite View finished saving the OSM file.

onMarkupSaving Autodesk OnSite View started saving the OSM file.

onMarkupUnloaded Autodesk OnSite View finished unloading the OSM file.

onMenuItemSelected A user has selected a custom menu item.

onSelectionChanged A user or an add-in changed the drawing selection.

onUnloading Autodesk OnSite View started unloading the add-in.

onViewChanged The display finished refreshing.

onViewChanging The display started refreshing.

IOSAddIn Events Action That Triggers the Event (continued)
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*pMenuID)

Parameters

[out] pMenuItemName—The text of the menu item

[out] pMenuID—A number that uniquely identifies this menu item; subse-
quent events that pertain to this menu item use this ID.

Description

Autodesk OnSite View calls this method when the application initializes to 
get the first custom menu item. To add a menu item, return the menu item 
text for pMenuItemName and a unique identifier for pMenuID. Because this 
method is only called once, during application initialization, you cannot 
dynamically change menu items.

To indicate that there are no custom menu items, return a value of –1 for 
pMenuID. If you are not using custom menu items, you do not need to 
implement this method. 

See Also

IOSAddIn::getNextMenuItem on page 53

IOSAddIn::getNextMenuItem

Gets the next custom menu item to add to the application. 

HRESULT getNextMenuItem([out] BSTR *pMenuItemName, [out] short 
*pMenuID)

Parameters

[out] pMenuItemName—The text of the menu item

[out] pMenuID—An identifier that uniquely identifies this menu item; subse-
quent events that pertain to this menu item use this ID.

Description

Autodesk OnSite View calls this method after calling 
IOSAddIn:getFirstMenuItem to get the second and subsequent add-in menu 
items. The system calls this method multiple times, until pMenuItemName 
is empty or pMenuID is –1. Because this process occurs only once, during 
application initialization, you cannot dynamically change menu items.
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See Also

IOSAddIn::getFirstMenuItem on page 52

IOSAddIn::isMenuItemChecked

Determines whether to display a custom menu item as checked or 
unchecked.

HRESULT isMenuItemChecked([in] short MenuID, [out] VARIANT_BOOL* 
pChecked)

Parameters

[in] MenuID—The menuID for the selected menu item. Use the MenuID 
returned by IOSAddIn’s getFirstMenuItem or getNextMenuItem methods.

[out] pChecked—Return VARIANT_TRUE to place a check mark beside the 
menu item. Otherwise, return VARIANT_FALSE.

Description

Autodesk OnSite View calls this method to determine how to display custom 
menu items. When the application refreshes the menus, it calls this method 
once for each custom menu item. If the method returns VARIANT_TRUE in 
the pChecked argument, the application displays a check mark beside the 
menu item. 

See Also

IOSAddIn::isMenuItemEnabled on page 54

IOSAddIn::getFirstMenuItem on page 52

IOSAddIn::getNextMenuItem on page 53

IOSAddIn::isMenuItemEnabled

Determines whether to display an custom menu item as enabled or disabled. 

HRESULT isMenuItemEnabled([in] short MenuID, [out] VARIANT_BOOL 
*pEnabled)
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Parameters

[in] MenuID—The menuID for the selected menu item. Use the MenuID 
returned by IOSAddIn’s getFirstMenuItem or getNextMenuItem methods.

[out] pEnabled—Return VARIANT_TRUE to enable the menu item. Other-
wise, return VARIANT_FALSE.

Description

Autodesk OnSite View calls this method to determine how to display custom 
menu items. When the application refreshes the menus, it calls this method 
once for each custom menu item. If the method returns VARIANT_TRUE for 
the pEnabled argument, the application enables the menu item. 

See Also

IOSAddIn::isMenuItemChecked on page 54

IOSAddIn::getFirstMenuItem on page 52

IOSAddIn::getNextMenuItem on page 53

IOSAddIn::onActivate

Autodesk OnSite View became active or inactive.

HRESULT onActivate([in] VARIANT_BOOL ActiveApp)

Parameters

[in] ActiveApp —Returns VARIANT_TRUE when Autodesk OnSite View 
becomes the active application. Returns VARIANT_FALSE when it becomes 
inactive.

See Also

IOSAddIn::onLoaded on page 59

IOSAddIn::onAppKillFocus

Autodesk OnSite View lost the focus. 

HRESULT onAppKillFocus()
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Parameters

This method has no parameters.

Description

This event is triggered when the focus on the handheld device changes from 
Autodesk OnSite View to another application.

See Also

IOSAddIn::onAppSetFocus on page 56

IOSAddIn::onAppSetFocus

Autodesk OnSite View got the focus. 

HRESULT onAppSetFocus()

Parameters

This method has no parameters.

Description

This event is triggered when the focus on the handheld device changes from 
another application to Autodesk OnSite View.

See Also

IOSAddIn::onAppKillFocus on page 55

IOSAddIn::onBeginShutdown

Autodesk OnSite View is requesting a shutdown. 

HRESULT onBeginShutdown([in] VARIANT_BOOL Forced, [out] 
VARIANT_BOOL *pStopShutdown)

Parameters

[in] Forced—VARIANT_TRUE if the shutdown is forced

[out] pStopShutdown—VARIANT_TRUE stops the shutdown
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Description

This event is useful for overriding a shutdown request. 

Warning Do not shut down your add-in by using this event because another 
add-in can cancel the shutdown.

See Also

IOSAddIn::onUnloading on page 67

IOSAddIn::onDrawingLoaded

Autodesk OnSite View finished loading an OSD file. 

HRESULT onDrawingLoaded()

Parameters

This method has no parameters.

Description

This event is triggered after the drawing is loaded but before the first refresh 
operation.

See Also

IOSAddIn::onDrawingUnloaded on page 58

IOSAddIn::onDrawingObjectTapAndHold

A user performed a tap-and-hold action on a drawing object. 

HRESULT onDrawingObjectTapAndHold([in] IOSDrawingObject 
*pDrawingObject)

Parameters

[in] *pDrawingObject—An interface to the target drawing object
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See Also

IOSAddIn::onMarkupObjectTapAndHold on page 64

IOSAddIn::onDrawingUnloaded

Autodesk OnSite View finished unloading an OSD file.

HRESULT onDrawingUnloaded()

Parameters

This method has no parameters.

See Also

IOSAddIn::onDrawingLoaded on page 57

IOSAddIn::onDrawingUnloading on page 58

IOSAddIn::onDrawingUnloading

Autodesk OnSite View began unloading an OSD file.

HRESULT onDrawingUnloading()

Parameters

This method has no parameters.

See Also

IOSAddIn::onDrawingLoaded on page 57

IOSAddIn::onDrawingUnloaded on page 58

IOSAddIn::onHibernate

The mobile device notified the application to hibernate.

HRESULT onHibernate()

Parameters

This method has no parameters.
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Description

Applications that have been inactive for an extended period may be asked to 
hibernate. The operating system sends this message to Autodesk OnSite View 
just before it demotes the application to the hibernate state. Add-ins should 
reduce memory usage upon receiving this event.

IOSAddIn::onLoaded

Autodesk OnSite View finished loading the add-in.

HRESULT onLoaded([in] IOSApplication *pApplication, [in] long hWnd)

Parameters

[in] pApplication—The root IOSApplication interface

[in] hWnd—The handle to the Autodesk OnSite View main window

Description

This event is the first opportunity an add-in gets to indicate its presence to 
the user. By using this event the add-in could, for example, visually change 
its control bars. This event provides a convenient way for the add-in to 
obtain a pointer to the interface of the application that loaded it.

The hWnd parameter simplifies the process of adding modal dialog boxes to 
an add-in. You can cast this parameter to HWND for compatibility with other 
C++ methods.

See Also

IOSAddIn::onLoading on page 59

IOSAddIn::onUnloading on page 67

IOSAddIn::onLoading

Autodesk OnSite View started loading the add-in.

HRESULT onLoading()

Parameters

This method has no parameters.
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Description

This event can initialize add-ins.

See Also

IOSAddIn::onLoaded on page 59

IOSAddIn::onMarkupGroupActive

A markup group became active.

HRESULT onMarkupGroupActive([in] IOSMarkupGroup *pMarkupGroup)

Parameter

[in] pMarkupGroup—The IOSMarkupGroup for which the event occurred

Description

This event is triggered when the active markup group changes. For example, 
the active markup group changes when an add-in invokes IOSMarkupLayer’s 
removeAllGroups, because Autodesk OnSite View deletes the currently active 
group and then creates a new empty group. The new markup group becomes 
the active markup group and triggers this event.

See Also

IOSAddIn::onMarkupGroupInactive on page 61

IOSAddIn::onMarkupGroupAdd

A user or an add-in added a markup group.

HRESULT onMarkupGroupAdd([in] IOSMarkupGroup *pMarkupGroup)

Parameter

[in] pMarkupGroup—The IOSMarkupGroup for which the event occurred

Description

This event is useful for identifying new markup groups and responding to the 
addition of these groups.
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See Also

IOSAddIn::onMarkupGroupModify on page 61

IOSAddIn::onMarkupGroupRemoving on page 62

IOSAddIn::onMarkupGroupInactive

A markup group became inactive.

HRESULT onMarkupGroupInactive([in] IOSMarkupGroup *pMarkupGroup)

Parameter

[in] pMarkupGroup—The IOSMarkupGroup for which the event occurred

Description

This event is triggered just after a markup group becomes inactive. For 
example, this event is triggered when a user clicks Done.

See Also

IOSAddIn::onMarkupGroupActive on page 60

IOSAddIn::onMarkupGroupModify

A user or an add-in modified a markup group.

HRESULT onMarkupGroupModify([in] IOSMarkupGroup *pMarkupGroup)

Parameters

[in] pMarkupGroup—The markup group interface on which the event 
occurred

Description

This event is useful for identifying a change to markup groups and 
responding to the change.

See Also

IOSAddIn::onMarkupGroupAdd on page 60
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IOSAddIn::onMarkupGroupRemoving on page 62

IOSAddIn::onMarkupGroupRemoving

A user or an add-in removed a markup group.

HRESULT onMarkupGroupRemoving([in] IOSMarkupGroup *pMarkupGroup)

Parameters

[in] pMarkupGroup—The markup group interface on which the event 
occurred

Description

This event is triggered just before removing a markup group. This event is 
useful for responding to markup group deletions.

See Also

IOSAddIn::onMarkupGroupAdd on page 60

IOSAddIn::onMarkupGroupModify on page 61

IOSAddIn::onMarkupLoaded

Autodesk OnSite View finished loading an OSM file.

HRESULT onMarkupLoaded()

Parameters

This method has no parameters.

Description

This event is triggered after the markup file is loaded but before the first 
refresh operation. If this event does not follow the onMarkupLoading event, 
the markup file failed to load.

See Also

IOSAddIn::onMarkupLoading on page 63

IOSAddIn::onMarkupUnloaded on page 65
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IOSAddIn::onMarkupLoading

Autodesk OnSite View started loading an OSM file.

HRESULT onMarkupLoading()

Parameters

This method has no parameters.

Description

This event is triggered before the markup file is loaded.

See Also

IOSAddIn::onMarkupLoaded on page 62

IOSAddIn::onMarkupUnloaded on page 65

IOSAddIn::onMarkupObjectAdd

A user or an add-in added a markup object.

HRESULT onMarkupObjectAdd([in] IOSMarkupObject *pMarkupObject)

Parameters

[in] pMarkupObject—The markup interface on which the event occurred

Description

This event is useful for identifying new markup objects and responding to a 
user or an add-in adding them.

See Also

IOSAddIn::onMarkupObjectModify on page 63

IOSAddIn::onMarkupObjectRemoving on page 64

IOSAddIn::onMarkupObjectModify

A user or an add-in modified a markup object.

HRESULT onMarkupObjectModify([in] IOSMarkupObject *pMarkupObject)
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Parameters

[in] pMarkupObject—The markup object interface on which the event 
occurred

Description

This event is useful for identifying a change to markup objects and 
responding to the change.

See Also

IOSAddIn::onMarkupObjectAdd on page 63

IOSAddIn::onMarkupObjectRemoving on page 64

IOSAddIn::onMarkupObjectRemoving

A user or an add-in removed a markup object. 

HRESULT onMarkupObjectRemoving()

Parameters

This method has no parameters.

See Also

IOSAddIn::onMarkupObjectAdd on page 63

IOSAddIn::onMarkupObjectModify on page 63

IOSAddIn::onMarkupObjectTapAndHold

A user performed a tap-and-hold action on a markup object. 

HRESULT onMarkupObjectTapAndHold([in] IOSMarkupObject 
*pMarkupObject)

Parameters

[in] *pMarkupObject—An interface to the target markup object
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Description

This event is triggered after a user taps and holds the stylus on a markup 
object.

See Also

IOSAddIn::onDrawingObjectTapAndHold on page 57

IOSAddIn::onMarkupSaved

Autodesk OnSite View finished saving an OSM file.

HRESULT onMarkupSaved()

Parameters

This method has no parameters.

See Also

IOSAddIn::onMarkupSaving on page 65

IOSAddIn::onMarkupSaving

Autodesk OnSite View started saving an OSM file.

HRESULT onMarkupSaving()

Parameters

This method has no parameters.

See Also

IOSAddIn::onMarkupSaved on page 65

IOSAddIn::onMarkupUnloaded

Autodesk OnSite View finished unloading an OSM file.

HRESULT onMarkupUnloaded()
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Parameters

This method has no parameters.

See Also

IOSAddIn::onMarkupLoaded on page 62

IOSAddIn::onMarkupLoading on page 63

IOSAddIn::onMarkupUnloaded on page 65

IOSAddIn::onMenuItemSelected

A user tapped a custom menu item.

HRESULT onMenuItemSelected([in] short MenuID)

Parameters

[in] MenuID—The menuID for the selected menu item

Description

This event notifies the add-in that a user tapped one of its custom menu 
items. Check the MenuID to identify the menu item.

See Also

IOSAddIn::isMenuItemChecked on page 54

IOSAddIn::isMenuItemEnabled on page 54

IOSAddIn::onSelectionChanged

A user or an add-in changed the drawing selection. 

HRESULT onSelectionChanged ()

Parameters

This method has no parameters.
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Description

This event is triggered just after a user or an add-in changes a selection, for 
example, from no selections to one or from multiple selections to none. 
Because no single object changes, this method does not return an object. You 
search the hierarchy of objects to identify which items are currently selected.

See Also

IOSAddIn::onDrawingObjectTapAndHold on page 57

IOSAddIn::onMarkupObjectTapAndHold on page 64

IOSAddIn::onUnloading

Autodesk OnSite View started unloading the add-in.

HRESULT onUnloading()

Parameters

This method has no parameters.

Description

This event offers the last chance for add-ins to interact with Autodesk OnSite 
View before it shuts down. It is also useful for showing shutdown dialog 
boxes.

See Also

IOSAddIn::onLoading on page 59

IOSAddIn::onViewChanged

The view of the drawing finished refreshing.

HRESULT onViewChanged()

Parameters

This method has no parameters.
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Description

Use this event to update the view after the drawing is refreshed. 

See Also

IOSAddIn::onViewChanging on page 68

IOSAddIn::onViewChanging

The view of a drawing started refreshing.

HRESULT onViewChanging()

Parameters

This method has no parameters.

Description

Use this event to update the view every time the drawing is refreshed. Use the 
onDrawingLoaded event instead of this event to initialize settings the first 
time Autodesk OnSite View displays a drawing.

See Also

IOSAddIn::onViewChanged on page 67

IOSAddIn::onDrawingLoaded on page 57
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IOSDrawing Interface

The IOSDrawing interface represents a loaded OSD file. This interface 
controls the visual aspects of an Autodesk OnSite View drawing and provides 
access to its markup layer, drawing layers, and other attributes.

IOSDrawing Attributes

The following table summarizes the IOSDrawing attributes and detailed 
descriptions follow the table. 

IOSDrawing
Attribute

Description Access

Application The base IOSApplication interface. Read only

AutoRefresh A flag that controls refresh behavior when the 
drawing changes.

Read/Write

BaseDrawingFileName The file name of the Autodesk OnSite View 
(OSD) drawing.

Read only

BaseDrawingSource
FileName 

The file name of the original MWF, DXF, or 
DWG drawing.

Read only

CenterX The X value of the centerpoint for the active 
view.

Read/Write

CenterY The Y value of the centerpoint for the active 
view.

Read/Write

DrawingLayers The collection of drawing layers from a 
drawing.

Read only

MarkupLayer A markup layer interface for a drawing. Read only

Projection The OpenGIS Consortium Well-Known Text 
representation for a spatial reference system.

Read only

UnitConversionFactor The multiplier for converting drawing units to 
meters.

Read only
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IOSDrawing Application Attribute

The base IOSApplication interface.

HRESULT getApplication([out] IOSApplication **ppApplication) 

Parameters

[out] ppApplication—A pointer to the parent IOSApplication interface

See Also

IOSApplication on page 47

IOSDrawing AutoRefresh Attribute

The automatic refresh flag.

HRESULT getAutoRefresh([out] VARIANT_BOOL *pAutoRefresh) 

HRESULT setAutoRefresh([in] VARIANT_BOOL newAutoRefresh) 

Parameters

[out] pAutoRefresh—The automatic refresh flag state

[in] newAutoRefresh—The desired automatic refresh behavior, either 
VARIANT_TRUE to enable it or VARIANT_FALSE to disable it

Description

The AutoRefresh attribute of the drawing interface controls the refresh 
behavior when the drawing changes. Autodesk OnSite View automatically 
refreshes the drawing if AutoRefresh is enabled. The drawing always refreshes 
when onDrawingLoaded, onViewChanging, or onMarkupLoaded events 
execute, regardless of the state of the AutoRefresh attribute. Only selected 

ViewScale The scale factor for the view. Read/Write

ViewX The X value of the active view extent. Read/Write

ViewY The Y value of the active view extent. Read/Write

IOSDrawing
Attribute

Description (continued) Access
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methods refresh the display. For more information, see “Refreshing” on 
page 36.

You can also update the view by invoking the refresh method of the drawing 
interface. To manually control the refresh operation, disable AutoRefresh and 
invoke the refresh method when necessary. For example, when you add 
markups, you might want to inhibit the automatic refresh until you are 
finished adding the markups. 

See Also

IOSDrawing::refresh on page 78

IOSAddIn::onDrawingLoaded on page 57

IOSAddIn::onMarkupLoaded on page 62

IOSAddIn::onViewChanging on page 68

IOSDrawing BaseDrawingFileName Attribute

The file name of the OSD drawing.

HRESULT getBaseDrawingFileName([out] BSTR *pBaseDrawingFileName)

Parameters

[out] pBaseDrawingFileName—The fully qualified path and file name for the 
OSD file, for example, \My Documents\sample.osd; returns a NULL BSTR * if 
the attribute is empty

See Also

IOSDrawing BaseDrawingSourceFileName attribute on page 71

IOSDrawing BaseDrawingSourceFileName Attribute

The file name of the source drawing.

HRESULT getBaseDrawingSourceFileName([out] BSTR 
*pBaseDrawingSourceFileName)

Parameters

[out] pBaseDrawingSourceFileName—The MWF, DXF, or DWG drawing 
name, such as http://www.myserver.com/sample.mwf or 
C:\StagingDir\sample.dxf; returns a NULL BSTR * if the attribute is empty.
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Description

Use this attribute to match the source file and the OSD file. The source files 
are DWG, DXF, or MWF files. Knowing the type of file associated with an 
OSD is important for merging the subsequent OSM file markups with the 
source file.

See Also

IOSDrawing BaseDrawingFileName attribute on page 71

IOSDrawing CenterX Attribute

The X value of the centerpoint for the active view.

HRESULT getCenterX([out] double *pCenterX)

HRESULT setCenterX([in] double newCenterX)

Parameters

[out] pCenterX—The horizontal center of the active view, expressed in WCS 
units

[in] newCenterX—The new horizontal center for the active view, expressed 
in WCS units

Description

The application interprets this attribute in WCS units, for example meters or 
feet. Setting the X coordinate of the centerpoint moves the active view 
horizontally across the map or drawing.

The setCenterX method always refreshes the map or drawing when the 
method is called from onViewChanging, onDrawingLoaded, or 
onMarkupLoaded event code. When called from the event code of other 
event handlers, this method refreshes the drawing only if the AutoRefresh 
attribute is set to VARIANT_TRUE.

See Also

IOSDrawing CenterY attribute on page 73

IOSDrawing ViewScale attribute on page 75
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IOSDrawing CenterY Attribute

The Y value of the centerpoint for the active view.

HRESULT getCenterY([out] double *pCenterY)

HRESULT setCenterY([in] double newCenterY)

Parameters

[out] pCenterY—The vertical center of the active view, expressed in WCS 
units

[in] newCenterY—The new vertical center for the active view, expressed in 
WCS units

Description

The application interprets this attribute in WCS units, for example meters or 
feet. Setting this attribute moves the active view vertically across the map or 
drawing.

The setCenterY method always refreshes the map or drawing when the 
method is called from onViewChanging, onDrawingLoaded, or 
onMarkupLoaded event code. When called from the event code of other 
event handlers, this method refreshes the drawing only if the AutoRefresh 
attribute is set to VARIANT_TRUE.

See Also

IOSDrawing CenterX attribute on page 72

IOSDrawing ViewScale attribute on page 75

IOSDrawing DrawingLayers Attribute

The collection of drawing layers from the drawing.

HRESULT getDrawingLayers([out] IOSDrawingLayerCollection 
**ppDrawingLayers)

Parameters

[out] ppDrawingLayers—The collection of drawing layer interfaces
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See Also

IOSMarkupGroup MarkupLayer attribute on page 101

IOSDrawing MarkupLayer Attribute

The markup layer for a drawing.

HRESULT getMarkupLayer([out] IOSMarkupLayer **ppMarkupLayer)

Parameters

[out] ppMarkupLayer—A pointer to the markup layer interface

See Also

IOSDrawing DrawingLayers attribute on page 73

IOSDrawing Projection Attribute

The OpenGIS Consortium Well-Known Text representation for a spatial refer-
ence system.

HRESULT getProjection([out] BSTR *pProjection)

Parameters

[out] pProjection—An OpenGIS projection type, expressed as a text string. 
Returns a NULL BSTR * if the attribute is empty. For more information, see 
“Parsing the Projection String” on page 39. 

See Also

IOSDrawing BaseDrawingFileName attribute on page 71

IOSDrawing UnitConversionFactor Attribute

The multiplier for converting drawing units to meters. For more information, 
see “Understanding Units of Measurement” on page 38.

HRESULT getUnitConversionFactor([out] double 
*pUnitConversionFactor)
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Parameters

[out] pUnitConversionFactor—The number of drawing units that correspond 
to one meter

IOSDrawing ViewScale Attribute

The scale factor for the display.

HRESULT getViewScale([out] double *pViewScale)

HRESULT setViewScale([in] double newViewScale)

Parameters

[out] pViewScale—The scale factor of the view, interpreted as 1:pViewScale

[in] newViewScale—The new scale factor for the view. Increasing values 
causes a zoom out.

Description

The setViewScale method always refreshes the map or drawing when the 
method is called from onViewChanging, onDrawingLoaded, or 
onMarkupLoaded event code. When called from the event code of other 
event handlers, this method refreshes the drawing only if the AutoRefresh 
attribute is set to VARIANT_TRUE.

See Also

IOSDrawing CenterX attribute on page 72

IOSDrawing CenterY attribute on page 73

IOSDrawing ViewX Attribute

The X value of the active view extent. The view extent is the rectangle that 
encloses that portion of the drawing that appears. 

HRESULT getViewX([out] double *pViewX)

HRESULT setViewX([in] double newViewX)

Parameters

[out] pViewX—The X value of the extent, expressed in the WCS units of the 
original drawing, such as meters or miles; for example, 23.00000 meters.
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[in] newViewX—The new X value for the extent, expressed in the WCS units 
of the original drawing, such as meters or feet. Increasing values causes a 
zoom out.

Description

The setViewX method always refreshes the map or drawing when the 
method is called from onViewChanging, onDrawingLoaded, or 
onMarkupLoaded event code. When called from the event code of other 
event handlers, this method refreshes the drawing only if the AutoRefresh 
attribute is set to VARIANT_TRUE.

See Also

IOSDrawing ViewY attribute on page 76

IOSDrawing ViewY Attribute

The Y value of the view extent. The view extent is the rectangle that encloses 
that portion of the drawing that appears. 

HRESULT getViewY([out] double *pViewY)

HRESULT setViewY([in] double newViewY)

Parameters

[out] pViewY—The Y value of the extent, expressed in the WCS units of the 
original drawing, such as meters or feet; for example, 52.00000 feet

[in] newViewY—The new Y value for the extent, expressed in the WCS units 
of the original drawing, such as meters or feet. Increasing values cause a 
zoom out.

Description

The setViewY method always refreshes the map or drawing when the method 
is called from onViewChanging, onDrawingLoaded, or onMarkupLoaded 
event code. When called from the event code of other event handlers, this 
method refreshes the drawing only if the AutoRefresh attribute is set to 
VARIANT_TRUE.

See Also

IOSDrawing ViewX attribute on page 75
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IOSDrawing Methods

The following table summarizes the IOSDrawing methods and a detailed 
description follows the table.

IOSDrawing::closeDrawing

Closes a drawing file on the mobile device.

HRESULT closeDrawing()

Parameters

This method has no parameters.

Description

Use this method to close an Autodesk OnSite View drawing or markup file 
when it’s no longer needed. The associated drawing or markup layers remain, 
but no longer display the file. Because this method does not automatically 
refresh the display, you should call the refresh method afterwards.

See Also

IOSDrawing::refresh on page 78

IOSDrawing Method Description

closeDrawing Closes a drawing file on the mobile device.

openFile Opens a drawing file on the mobile device.

refresh Refreshes the drawing.

zoomExtent Zooms to the largest possible view of the 
entire drawing.

zoomScale Zooms to the specified centerpoint and 
scale.

zoomSelected Zooms to the largest possible view of all 
selected objects.
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IOSDrawingLayer on page 83

IOSMarkupLayer on page 107

IOSDrawing::openFile

Opens a drawing file on the mobile device.

HRESULT openFile([in] BSTR FileNamePath)

Parameters

[in] FileNamePath—The fully-qualified path to the drawing file and the file 
name. Valid file types are OnSite Drawing (.osd) and OnSite Markup (.osm) 
files. For example, \My Documents\Sample.osd.

Description

Use this method to open an OnSite drawing or markup file and display it on 
the user interface. Drawing and markup files open on drawing and markup 
layers, respectively.

See Also

IOSDrawingLayer on page 83

IOSMarkupLayer on page 107

IOSDrawing::refresh

Refreshes the drawing.

HRESULT refresh()

Parameters

This method has no parameters.

Description

Use this method to force a refresh after changing attributes that do not cause 
an automatic refresh to occur. This method refreshes the drawing uncondi-
tionally, regardless of the state of the AutoRefresh attribute. 

Note The refresh method fails if called from the event-handling code for 
onViewChanging, onDrawingLoaded, or onMarkupLoaded events.
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See Also

IOSAddIn::onDrawingLoaded on page 57

ISOAddIn::onMarkupLoaded on page 62

IOSAddIn::onViewChanging on page 68

IOSDrawing AutoRefresh attribute on page 70

IOSDrawing CenterX attribute on page 72

IOSDrawing CenterY attribute on page 73

IOSDrawing ViewScale attribute on page 75

IOSDrawing ViewX attribute on page 75

IOSDrawing ViewY attribute on page 76

IOSDrawing::zoomExtent on page 79

IOSDrawing::zoomScale on page 80

IOSDrawing::zoomSelected on page 81

IOSDrawingObject SelectedState attribute on page 91

IOSMarkupGroup::removeAllObjects on page 104

IOSMarkupGroup::removeMarkupObject on page 104

IOSMarkupGroup SelectedState attribute on page 102

IOSMarkupLayer ActiveMarkupGroup attribute on page 108

IOSMarkupLayer::removeAllGroups on page 110

IOSMarkupLayer::removeMarkupGroup on page 111

IOSMarkupObject SelectedState attribute on page 113

IOSMarkupObject LeaderPrimitive attribute on page 114

IOSMarkupObject NotePrimitive attribute on page 115

IOSMarkupObject PolylinePrimitive attribute on page 115

IOSMarkupObject SymbolPrimitive attribute on page 116

IOSDrawing::zoomExtent

Zooms to the largest possible view of the entire drawing.

HRESULT zoomExtent()
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Parameters

This method has no parameters.

Description

Use this method to zoom to the full extent of the drawing window. Typically, 
the full extent is the smallest rectangle that contains all objects in the 
drawing, positioned on the screen to display the largest possible view of all 
objects. Drawing extents are defined in the OSD and markup files.

The zoomExtent method always refreshes the map or drawing when the 
method is called from onViewChanging, onDrawingLoaded, or 
onMarkupLoaded event code. When called from the event code of other 
event handlers, this method refreshes the drawing only if the AutoRefresh 
attribute is set to VARIANT_TRUE. 

See Also

IOSDrawingLayer on page 83

IOSMarkupLayer on page 107

IOSDrawing::zoomScale

Zooms to the specified centerpoint and scale.

HRESULT zoomScale([in] double CenterX, [in] double CenterY, [in] 
double Scale)

Parameters

[in] CenterX—The horizontal center of the display, in WCS units

[in] CenterY—The vertical center of the display, in WCS units

[in] Scale—The view scale to use, interpreted as 1:Scale. For example, 
1:2500.000 specifies that one inch on the display corresponds to 2500 inches 
in the real world.

Description

Use this method to zoom to the specified centerpoint and scale. Specify the 
X and Y coordinates of the centerpoint, CenterX and CenterY, by using the 
WCS units of the original drawing, such as feet or miles. These coordinates 
can be either positive or negative numbers, and are relative to the origin of 
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the drawing. The origin of an OSD drawing corresponds to the origin of the 
source DWG, DXF, or MWF drawing.

Choose a view scale by using the ratio inferred by 1:Scale. For example, a 
scale of 1:2500.000 means that 1 display unit represents 2500 real world 
units. Any value greater than zero is valid, but individual layers may have 
minimum and maximum display ranges.

The zoomScale method always refreshes the map or drawing when the 
method is called from onViewChanging, onDrawingLoaded, or 
onMarkupLoaded event code. When called from the event code of other 
event handlers, this method refreshes the drawing only if the AutoRefresh 
attribute is set to VARIANT_TRUE. 

See Also

IOSDrawingLayer on page 83

IOSMarkupLayer on page 107

IOSDrawing::zoomSelected

Zooms to the largest possible view of all selected objects.

HRESULT zoomSelected ()

Parameters

This method has no parameters.

Description

Use this method to zoom to an extent that includes the selected objects. This 
extent is the smallest rectangle that contains all selected objects, positioned 
on the screen to display the largest possible view. If no objects are selected, 
the method has no effect.

The zoomSelected method always refreshes the map or drawing when the 
method is called from onViewChanging, onDrawingLoaded, or 
onMarkupLoaded event code. When called from the event code of other 
event handlers, this method refreshes the drawing only if the AutoRefresh 
attribute is set to VARIANT_TRUE.

See Also

IOSDrawingLayer on page 83
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IOSMarkupLayer on page 107
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IOSDrawingLayer Interface

The IOSDrawingLayer interface represents a layer on the drawing. Layers 
help organize drawing objects that represent similar features, such as road-
ways, buildings, or waterways. This interface contains basic drawing infor-
mation that you cannot modify.

Note You cannot create public instances of the IOSDrawingLayer class. 

IOSDrawingLayer Attributes

The following table summarizes the IOSDrawingLayer attributes and detailed 
descriptions follow the table.

IOSDrawingLayer Drawing Attribute

The parent drawing interface.

HRESULT getDrawing([out] IOSDrawing **ppDrawing)

IOSDrawingLayer 
Attribute

Description Access

Drawing The parent drawing interface. Read only

DrawingObjects The drawing features on the layer. Read only

Extent The drawing layer extent. Read only

MaxDisplayRange The maximum scale at which the layer displays 
data.

Read only

MinDisplayRange The minimum scale at which the layer displays 
data.

Read only

Name The name of the drawing layer. Read only

NowDisplayed The displayed state of the layer. Read only

VisibleState The visibility state of the layer. Read/Write
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Parameters

[out] ppDrawing—A pointer to the parent drawing

See Also

IOSDrawing Layer DrawingObjects attribute

IOSDrawingLayer DrawingObjects Attribute

A collection containing all the drawing features on the layer. You cannot 
modify these features, but you can traverse the collection to get their names, 
database keys, hyperlinks, such as map features that were linked in the base 
MWF file, and other information.

HRESULT getDrawingObjects([out] IOSDrawingObjectCollection 
**ppDrawingObjects)

Parameters

[out] ppDrawingObjects—The collection of drawing interfaces

See Also

IOSDrawingLayer Drawing attribute on page 83

IOSDrawingLayer Extent Attribute

The drawing layer extent interface. The drawing layer extent is the smallest 
rectangle that contains all drawing layer objects.

HRESULT getExtent([out] IOSExtent **ppExtent)

Parameters

[out] ppExtent—The drawing layer extent interface

See Also

IOSDrawing zoomExtent attribute on page 79

IOSDrawingLayer MaxDisplayRange Attribute

The maximum scale at which the layer displays data. Setting the viewScale 
attribute to the value of MaxDisplayRange displays the entire layer. 
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HRESULT getMaxDisplayRange([out] double *pMaxDisplayRange)

Parameters

[out] pMaxDisplayRange—The maximum view scale, such as 2500.0000, for 
the drawing layer; returns –1 if there is no maximum view scale

See Also

IOSDrawingLayer MinDisplayRange attribute on page 85

IOSDrawingLayer VisibleState attribute on page 86

IOSDrawingLayer MinDisplayRange Attribute

The minimum scale at which the layer displays data. Setting the viewScale 
attribute to the value of MinDisplayRange displays the greatest layer detail. 

HRESULT getMinDisplayRange([out] double *pMinDisplayRange)

Parameters

[out] pMinDisplayRange—The minimum view scale, such as 250.0000, for 
the drawing layer; returns –1 if there is no minimum scale

See Also

IOSDrawingLayer MaxDisplayRange attribute on page 84

IOSDrawingLayer VisibleState attribute on page 86

IOSDrawingLayerName Attribute

Gets the name of the drawing layer. The name of a layer may suggest its 
content or usage, such as roadways. 

HRESULT getName([out] BSTR *pName)

Parameters

[out] pName—The name, such as electrical, of the drawing layer; returns a 
NULL BSTR * if the attribute is empty

IOSDrawingLayer NowDisplayed Attribute

The display status of the drawing layer. 
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HRESULT getNowDisplayed([out] VARIANT_BOOL *pNowDisplayed)

Parameters

[out] pNowDisplayed—The display status of the layer on the user interface. 
A value of VARIANT_TRUE indicates that the map layer is visible on the 
display. VARIANT_FALSE means either the current scale of the drawing is 
outside the display range of the drawing or the drawing layer is off.

See Also

IOSDrawingLayer VisibleState attribute on page 86

IOSDrawingLayer VisibleState Attribute

The visibility state of the layer. 

HRESULT getVisibleState([out] VARIANT_BOOL *pVisibleState)

HRESULT setVisibleState([in] VARIANT_BOOL newVisibleState)

Parameters

[out] pVisibleState—The visibility state of the layer. VARIANT_TRUE if visible

[in] newVisibleState—The new visibility state of the layer

Description

The map layer is potentially visible when the value is VARIANT_TRUE. The 
NowDisplayed attribute indicates whether the map layer appears at the 
current map scale.

This method does not automatically refresh the map or drawing. To redraw 
the map or drawing, use the refresh method.

See Also

IOSDrawingLayer NowDisplayed attribute on page 85

IOSDrawing::refresh on page 78
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IOSDrawingLayerCollection Interface

IOSDrawing’s getDrawingLayers method returns the collection of layers, 
which IOSDrawingLayerCollection represents.

IOSDrawingLayerCollection Attribute

The following table lists the IOSDrawingLayerCollection attribute and a 
detailed description follows the table.

IOSDrawingLayerCollection NumObjects Attribute

This attribute quantifies the number of drawing layers in the collection.

HRESULT getNumObjects([out] long *pNumObjects)

Parameters

[out] pNumObjects—The number of drawing layers that the collection 
contains

IOSDrawingLayerCollection Methods

The following table summarizes the IOSDrawingLayerCollection methods 
and a detailed description follows the table.

IOSDrawingLayer
Collection Attribute

Description Access

NumObjects The number of drawing layers in the 
collection.

Read only

IOSDrawingLayerCollection
Method

Description

isEmpty Tests the collection for the empty state.

item Gets an item from the collection.
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IOSDrawingLayerCollection::isEmpty

This method tests for an empty collection.

HRESULT isEmpty([out] VARIANT_BOOL *pIsEmpty)

Parameters

[out] pIsEmpty—The result of the test, either VARIANT_TRUE or 
VARIANT_FALSE

Description

If the collection contains one or more drawing layers, the pIsEmpty param-
eter returns VARIANT_TRUE. Otherwise, it returns VARIANT_FALSE. 

You can also test for the empty condition by checking the NumObjects 
attribute. A collection is empty if the NumObjects attribute is zero. 

See Also

IOSDrawingLayerCollection NumObjects attribute on page 87

IOSDrawingLayerCollection::item

Gets a drawing layer interface from the collection.

HRESULT item([in] long Index, [out] IOSDrawingLayer **ppResult)

Parameters

[in] Index—The location of the desired drawing layer in the collection

[out] ppResult—The drawing layer retrieved from the collection

Description

This method gets the drawing layer at the specified index. Valid index values 
are zero to NumObjects minus one.

See Also

IOSDrawingLayerCollection NumObjects attribute on page 87
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IOSDrawingObject Interface

The IOSDrawingObject interface represents a feature on the drawing. You 
cannot modify an IOSDrawingObject, but you can create or remove drawing 
objects, by using methods such as createMarkupObject.

IOSDrawingObject Attributes

The following table summarizes the IOSDrawingObject attributes and a 
detailed description follows the table.

IOSDrawingObject DrawingLayer Attribute

The drawing layer that contains the drawing feature.

HRESULT getDrawingLayer([out] IOSDrawingLayer **ppDrawingLayer)

Parameters

[out] ppDrawingLayer—A pointer to the parent drawing layer interface

See Also

IOSDrawingLayer getDrawingObjects attribute on page 84

IOSDrawing
Object Attribute

Description Access

DrawingLayer The drawing layer that contains the drawing 
feature.

Read only

Extent The drawing feature extent as a IOSExtent. Read only

Key The access control key of the drawing feature. Read only

Link The URL link associated with the drawing 
feature.

Read only

Name The name of the drawing feature. Read only

SelectedState The selected state of the drawing feature. Read/Write
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IOSDrawingObject Extent Attribute

The extent of the drawing feature, which is returned as an IOSExtent.

HRESULT getExtent([out] IOSExtent **ppExtent)

Parameters

[out] ppExtent—The IOSExtent interface

IOSDrawingObject Key Attribute

The access control key of the drawing feature.

HRESULT getKey([out] BSTR *pKey)

Parameters

[out] pKey—The drawing object key, expressed as an alphanumeric string, 
such as AE123FG0002321; returns a NULL BSTR * if the attribute is empty

Description

Autodesk MapGuide MWF files identify map features with a unique key, and 
AutoCAD DWG files identify drawing objects with a handle. Autodesk 
OnSite Enterprise includes either the key or the handle in OnSite drawings 
(OSD) that it converts from either an MWF or DWG file, respectively. This 
key is useful when linking objects to an external database.

IOSDrawingObject Link Attribute

The URL link associated with the drawing feature. Use this URL with action 
events, such as onMarkupObjectClickAndHold, to open a Web page in the 
browser:

HRESULT getLink([out] BSTR *pLink)

Parameters

[out] pLink—The URL associated with the drawing feature and expressed as 
an alphanumeric string, such as http://www.autodesk.com; returns a NULL 
BSTR * if the attribute is empty
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See Also

IOSAddIn::onDrawingObjectTapAndHold on page 57

IOSAddIn::onMarkupObjectTapAndHold on page 64 

IOSDrawingObject Name Attribute

The name of the drawing feature.

HRESULT getName([out] BSTR *pName)

Parameters

[out] pName—The name of the drawing object, expressed as an alphanu-
meric string, such as City Hall; returns a NULL BSTR * if the attribute is empty

IOSDrawingObject SelectedState Attribute

The selected state of the drawing feature. 

HRESULT getSelectedState([out] VARIANT_BOOL *pSelectedState)

HRESULT setSelectedState([in] VARIANT_BOOL newSelectedState)

Parameters

[out] pSelectedState—VARIANT_TRUE if the drawing object is currently 
selected

[in] newSelectedState—Set to VARIANT_TRUE to select the drawing object

Description

The setSelectedState method always refreshes the map or drawing when the 
method is called from onViewChanging, onDrawingLoaded, or 
onMarkupLoaded event code. When called from the event code of other 
event handlers, this method refreshes the drawing only if the AutoRefresh 
attribute is set to VARIANT_TRUE.
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IOSDrawingObjectCollection Interface

This collection contains the drawing object interfaces.

IOSDrawingObjectCollection Attribute

The following table summarizes the IOSDrawingObjectCollection attribute 
and a detailed description follows the table.

IOSDrawingObjectCollection NumObjects Attribute

This attribute quantifies the number of drawing features in the collection.

HRESULT getNumObjects([out] long *pNumObjects)

Parameters

[out] pNumObjects—The number of drawing features that the collection 
contains

IOSDrawingObjectCollection Methods

The following table summarizes the IOSDrawingObjectCollection methods 
and a detailed description follows the table.

IOSDrawingObject
Collection Attribute

Description Access

NumObjects The number of drawing objects in the 
collection.

Read only

IOSDrawingObjectCollection
Method

Description

isEmpty Tests the collection for the empty state.

item Gets an item from the collection.
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IOSDrawingObjectCollection::isEmpty

This method tests for an empty collection.

HRESULT isEmpty([out] VARIANT_BOOL *pIsEmpty)

Parameters

[out] pIsEmpty—The result of the test, either VARIANT_TRUE or 
VARIANT_FALSE

Description

If the collection contains one or more drawing features, the pIsEmpty param-
eter returns VARIANT_TRUE. Otherwise, it returns VARIANT_FALSE. 

You can also test for the empty condition by checking the NumObjects 
attribute. A collection is empty if the NumObjects attribute is zero. 

See Also

IOSDrawingObjectCollection NumObjects attribute on page 92

IOSDrawingObjectCollection::item

Gets an item from the collection.

HRESULT item([in] long Index, [out] IOSDrawingObject 
**ppDrawingObject)

Parameters

[in] Index—The location of the desired markup feature in the collection

[out] ppDrawingObject—The markup interface retrieved from the collection

Description

This method gets the markup feature interface at the specified index. Valid 
index values are zero to NumObjects minus one.

See Also

IOSDrawingObjectCollection NumObjects attribute on page 92
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IOSExtent Interface

An extent is a rectangle that encloses a drawing object, defined by the upper 
right and lower left cornerpoints in the drawing coordinate space. You 
cannot publicly create instances of the IOSExent. You call the getExtent 
method of the drawing, layer, or markup object to get the corresponding 
IOSExtent interface.

IOSExtent Attributes

The following table summarizes the IOSExtent attributes and a detailed 
description follows the table.

IOSExtent MaxX Attribute

The maximum X coordinate of the extent. This coordinate and the 
maximum Y coordinate define the upper right vertex of the extent rectangle.

HRESULT getMaxX([out] double *pMaxX)

Parameters

[out] pMaxX—The maximum X of the extent in WCS units

See Also

IOSExtent MaxY attribute on page 95

IOSExtent 
Attribute

Description Access

MaxX The maximum X coordinate of the extent. Read only

MaxY The maximum Y coordinate of the extent. Read only

MinX The minimum X coordinate of the extent. Read only

MinY The minimum Y coordinate of the extent. Read only
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IOSExtent MaxY Attribute

The maximum Y coordinate of the extent. This coordinate and the 
maximum X coordinate define the upper right vertex of the extent rectangle.

HRESULT getMaxY([out] double *pMaxY)

Parameters

 [out] pMaxY—The maximum Y of the extent in WCS units

See Also

IOSExtent MaxX attribute on page 94

IOSExtent MinX Attribute

The minimum X coordinate of the extent. This coordinate and the minimum 
Y coordinate define the lower left vertex of the extent rectangle.

HRESULT getMinX([out] double *pMinX)

Parameters

[out] pMinX—The minimum X of the extent in World Coordinate System 
units

See Also

IOSExtent MinY attribute on page 95

IOSExtent MinY Attribute

The minimum Y coordinate of the extent. This coordinate and the minimum 
X coordinate define the lower left vertex of the extent rectangle.

HRESULT getMinY([out] double *pMinY)

Parameters

[out] pMinY—The minimum Y extent in World Coordinate System units

See Also

IOSExtent MinX attribute on page 95
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IOSIntegerCollection Interface

This is a generic collection of integers. 

IOSIntegerCollection Attribute

The following table summarizes the IOSIntegerCollection attributes and a 
detailed description follows the table. 

IOSIntegerCollection NumObjects Attribute

This attribute quantifies the number of integers in the collection.

HRESULT getNumObjects([out] long *pNumObjects)

Parameters

[out] pNumObjects—The number of integers that the collection contains.

IOSIntegerCollection Methods

The following table summarizes the IOSIntegerCollection methods and a 
detailed description follows the table. 

IOSIntegerCollection
Attribute

Description Access

NumObjects The number of integers in the 
collection.

Read only

IOSIntegerCollection
Method

Description

isEmpty Tests for an empty collection.

add Adds an integer to the collection.
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IOSIntegerCollection::isEmpty

Tests for an empty collection.

HRESULT isEmpty([out] VARIANT_BOOL *pIsEmpty)

Parameters

[out] pIsEmpty—The result of the test, either VARIANT_TRUE or 
VARIANT_FALSE

Description

If the collection contains one or more integers, the pIsEmpty parameter 
returns VARIANT_TRUE. Otherwise, it returns VARIANT_FALSE. 

You can also test for the empty condition by checking the NumObjects 
attribute. A collection is empty if the NumObjects attribute is zero. 

See Also

IOSIntegerCollection NumObjects attribute on page 96

IOSIntegerCollection::add

Adds an integer to the collection.

HRESULT add([in] long Integer, [out] long *pIndex);

Parameters

[in] Integer—The integer to add to the collection

[out] pIndex—The location of the new integer in the collection

item Gets an integer from the collection.

remove Removes an integer from the collection.

removeAll Removes all integers from the collection.

IOSIntegerCollection
Method

Description (continued)
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Description

This method adds an integer to the collection and returns its location, spec-
ified as an index value. 

See Also

IOSIntegerCollection::item on page 98

IOSIntegerCollection::remove on page 98

IOSIntegerCollection::item

Gets an integer from the collection.

HRESULT item([in] long Index, [out] long *pInteger)

Parameters

[in] Index—The location of the desired integer in the collection

[out] pInteger—The integer retrieved from the collection

Description

This method gets the integer at the specified index.

See Also

IOSIntegerCollection::add on page 97

IOSIntegerCollection::remove

Removes an integer from the collection.

HRESULT remove([in] long Index)

Parameters

[in] Index—The location of the desired integer in the collection

Description

This method deletes the integer at the specified index.
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See Also

IOSIntegerCollection::add on page 97

IOSIntegerCollection::item on page 98

IOSIntegerCollection::removeAll

Removes all integers from the collection.

HRESULT removeAll()

Parameters

This method has no parameters.

Description

This method changes the collection to the empty state.

See Also

IOSIntegerCollection::remove on page 98
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IOSMarkupGroup Interface

The IOSMarkupGroup interface represents grouped markup primitives on 
the markup layer of the drawing. You cannot publicly create instances of 
IOSMarkupGroup. You can distinguish multiple markup groups by their 
unique IDs.

IOSMarkupGroup Attributes

The following table lists the IOSMarkupGroup attributes and a detailed 
description follows the table.

IOSMarkupGroup Author Attribute

The name of the author of the markup group. Autodesk OnSite View displays 
this attribute in the Markup Properties dialog box for a markup group. This 
name is also listed in the User Name field of the Drawing tab in the Options 
dialog box.

IOSMarkupGroup
Attribute

Description Access

Author The name of the author of the markup 
group.

Read only

Comment A comment associated with the markup 
group.

Read/Write

MarkupGroupID The unique ID of the markup group. Read only

MarkupLayer The markup layer associated with this 
markup group.

Read only

MarkupObjects The collection of markup interfaces in the 
markup group.

Read only

RevisedBy The author of revisions to the markup group. Read only

SelectedState The selection state of the markup group. Read/Write

Status The review status of the markup group. Read/Write
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HRESULT getAuthor([out] BSTR *pAuthor)

Parameters

[out] pAuthor—The name of the author of this group of markups; returns a 
NULL BSTR * if the attribute is empty

IOSMarkupGroup Comment Attribute

A comment associated with the markup group. Autodesk OnSite View 
displays this attribute in the Markup Attributes dialog box.

HRESULT getComment([out] BSTR *pComment)

HRESULT setComment([in] BSTR newComment)

Parameters

[out] pComment—The comments associated with a markup group; returns a 
NULL BSTR * if the attribute is empty

[in] newComment—A string of new comment text

IOSMarkupGroup MarkupGroupID Attribute

The unique ID of the markup group.

HRESULT getMarkupGroupID([out] long *pMarkupGroupID)

Parameters

[out] pMarkupGroupID—The identifier in the OSM file of the markup group

IOSMarkupGroup MarkupLayer Attribute

The markup layer associated with this markup group.

HRESULT getMarkupLayer([out] IOSMarkupLayer **ppMarkupLayer)

Parameters

[out] ppMarkupLayer—An interface to the markup layer

IOSMarkupGroup MarkupObjects Attribute

The collection of markups in the markup group.
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HRESULT getMarkupObjects([out] IOSMarkupObjectCollection 
**ppMarkupObjects)

Parameters

[out] ppMarkupObjects—An interface to the collection of markups

IOSMarkupGroup RevisedBy Attribute

The name of the user who last selected the markup. Autodesk OnSite View 
displays the author of revisions returned by this attribute in the Markup 
Properties dialog box of the markup object.

HRESULT getRevisedBy([out] BSTR *pRevisedBy)

Parameters

[out] pRevisedBy—The name representing the author of revisions to the 
mark ups; returns a NULL BSTR * if the attribute is empty

See Also

IOSMarkupGroup Comment attribute on page 101

IOSMarkupGroup SelectedState Attribute

The selected state of the markup group.

HRESULT getSelectedState([out] VARIANT_BOOL *pSelectedState)

HRESULT setSelectedState([in] VARIANT_BOOL newSelectedState)

Parameters

[out] pSelectedState— VARIANT_TRUE if the markup group is selected

[in] newSelectedState—Set to VARIANT_TRUE to select the group

Description

The setSelectedState method always refreshes the map or drawing when the 
method is called from onViewChanging, onDrawingLoaded, or 
onMarkupLoaded event code. When called from the event code of other 
event handlers, this method refreshes the drawing only if the AutoRefresh 
attribute is set to VARIANT_TRUE.
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IOSMarkupGroup Status Attribute

The review status of the markup group.

HRESULT getStatus([out] OSMarkupGroupStatus *pStatus)

HRESULT setStatus([in] OSMarkupGroupStatus newStatus)

Parameters 

[out] pStatus—The current review status, such as pending or rejected, of a 
markup group. For a list of values, see “Enumerated Data Types” on page 46.

[in] newStatus—The new review status, such as pending or rejected, of a 
markup group

See Also

OSMarkupGroupStatus. See “Enumerated Data Types,” on page 46.

IOSMarkupGroup Methods

The markup group methods add or remove specific markups, such as 
polylines and notes.

The following table summarizes the IOSMarkupGroup methods and a 
detailed description follows the table.

IOSMarkupGroup::createMarkupObject

Adds an empty feature to the markup group. 

HRESULT createMarkupObject([in] OSMarkupObjectType Type, [out] 
IOSMarkupObject **ppMarkupObject)

IOSMarkupGroup
Method

Description

createMarkupObject Adds an empty feature to the markup group.

removeAllObjects Deletes all markups from the group.

removeMarkupObject Removes a single IOSMarkupObject from the group.



104 | Chapter 2 The Autodesk OnSite View COM API Object Reference

Parameters

[in] Type—The type, such as Bézier or polyline, of the empty feature. For a 
list of values, see “Enumerated Data Types” on page 46.

[out] pMarkupObject—An empty feature in a markup group

Description

The returned markup interface has an ID attribute that uniquely identifies 
the object and is persistent for a given OSM file.

See Also

OSMarkupObjectType. See “Enumerated Data Types,” on page 46.

IOSMarkupGroup::removeAllObjects

Deletes all markups from the group. 

HRESULT removeAllObjects()

Description

Removes all objects and refreshes the drawing when the AutoRefresh 
attribute is set to VARIANT_TRUE or when the method is called from the 
onViewChanging or onViewChanged events. Calling this method on 
features in a selection triggers the onSelectionChanged event.

The removeAllObjects method always refreshes the map or drawing when 
the method is called from onViewChanging, onDrawingLoaded, or 
onMarkupLoaded event code. When called from the event code of other 
event handlers, this method refreshes the drawing only if the AutoRefresh 
attribute is set to VARIANT_TRUE.

IOSMarkupGroup::removeMarkupObject

Removes a single IOSMarkupObject from the group. 

HRESULT removeMarkupObject([in] IOSMarkupObject *pMarkupObject)

Parameters

[in] pMarkupObject—The interface to remove from the markup group
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Description 

Refreshes the drawing when the AutoRefresh attribute is set to 
VARIANT_TRUE or when the method is called from the onViewChanging or 
onViewChanged events. Calling this method on features in a selection trig-
gers the onSelectionChanged event.

The removeMarkupObject method always refreshes the map or drawing 
when the method is called from onViewChanging, onDrawingLoaded, or 
onMarkupLoaded event code. When called from the event code of other 
event handlers, this method refreshes the drawing only if the AutoRefresh 
attribute is set to VARIANT_TRUE.

See Also

IOSMarkupGroup::createMarkupObject on page 103

IOSMarkupGroupCollection Interface

This collection facilitates operations that work with the set of markup groups 
on a markup layer. You can examine and test the collection by using this 
interface. To add or delete items from a markup layer directly, use the 
IOSMarkupLayer interface.

IOSMarkupGroupCollection Attribute

The following table summarizes the IOSMarkupGroupCollection attribute 
and a detailed description follows the table.

IOSMarkupGroupCollection NumObjects Attribute

This attribute quantifies the number of markup objects in the collection.

HRESULT getNumObjects([out] long *pNumObjects)

IOSMarkupGroup
Collection Attribute

Description Access

NumObjects The number of markup groups in the 
collection.

Read only
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Parameters

[out] pNumObjects—The number of markup objects that the collection 
contains

Description

This method returns one more group than is visible, except when a user is 
adding markup objects and has not yet clicked the done button.

IOSMarkupGroupCollection Methods

The following table summarizes the IOSMarkupGroupCollection methods 
and a detailed description follows the table.

IOSMarkupGroupCollection::isEmpty

This method tests for an empty collection.

HRESULT isEmpty([out] VARIANT_BOOL *pIsEmpty)

Parameters

[out] pIsEmpty—The result of the test, either VARIANT_TRUE or 
VARIANT_FALSE

Description

If the collection contains one or more markup objects, the pIsEmpty param-
eter returns VARIANT_TRUE. Otherwise, it returns VARIANT_FALSE. 

You can also test for the empty condition by checking the NumObjects 
attribute. A collection is empty if the NumObjects attribute is zero. 

IOSMarkupGroupCollection
Method

Description

isEmpty Tests the collection for the empty state.

item Gets an item from the collection.
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See Also

IOSMarkupGroupCollection NumObjects attribute on page 105

IOSMarkupGroup on page 100

IOSMarkupGroupCollection::item

Gets an item from the collection.

HRESULT item([in] long Index, [out] IOSMarkupGroup **ppMarkupGroup)

Parameters

[in] Index—The location of the desired markup in the collection

[out] ppMarkupGroup—The markup interface retrieved from the collection

Description

This method gets the markup interface at the specified index. Valid index 
values are zero to NumObjects minus one.

See Also

IOSMarkupGroupCollection NumObjects attribute on page 105

IOSMarkupGroup on page 100

IOSMarkupLayer Interface

The IOSMarkupLayer interface represents the markup layer on the drawing. 
A markup layer is visually represented by a number of onscreen markups, but 
it is not a collection. There is only one markup layer per drawing, so you can 
work with only one markup layer at a time. You cannot add or remove the 
markup layer.
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IOSMarkupLayer Attributes

The following table summarizes the IOSMarkupLayer attributes and a 
detailed description follows the table.

IOSMarkupLayer ActiveMarkupGroup Attribute

The markup group with pending changes. 

HRESULT getActiveMarkupGroup([out] IOSMarkupGroup **ppMarkupGroup)

HRESULT setActiveMarkupGroup([in] IOSMarkupGroup *ppMarkupGroup)

Parameters

[out] ppMarkupGroup—A pointer to the active markup group interface; 
returns NULL if no active markup group exists

Description

The active markup group is the one currently being modified. By using this 
method, an add-in can view the active markup group or select a new one.

The setActiveMarkupGroup method always refreshes the map or drawing 
when the method is called from onViewChanging, onDrawingLoaded, or 
onMarkupLoaded event code. When called from the event code of other 
event handlers, this method refreshes the drawing only if the AutoRefresh 
attribute is set to VARIANT_TRUE.

See Also

IOSDrawing on page 69

IOSMarkupLayer
Attribute

Description Access

ActiveMarkupGroup The markup group currently in use. Read/Write

Drawing The drawing containing the markup layer. Read only

MarkupGroups A collection containing all the markup groups 
on the markup layer.

Read only
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IOSMarkupLayer Drawing Attribute

The drawing containing the markup layer.

HRESULT getDrawing([out] IOSDrawing **ppDrawing)

Parameters

[out] ppDrawing—A pointer to the parent IOSDrawing interface

See Also

IOSDrawing on page 69

IOSMarkupLayer MarkupGroups Attribute

A collection containing all the markup groups on the markup layer.

HRESULT getMarkupGroups([out] IOSMarkupGroupCollection 
**ppMarkupGroups)

Parameters

[out] ppMarkupGroups—The collection of markup interfaces

See Also

IOSMarkupLayer::createMarkupGroup on page 110

IOSMarkupLayer::removeMarkupGroup on page 111

IOSMarkupLayer Methods

The following table summarizes the IOSMarkupLayer methods and a detailed 
description follows the table.

IOSMarkupLayer
Method

Description

createMarkupGroup Adds an empty markup group to the markup layer.

removeAllGroups Deletes all markup groups from the markup layer.

removeMarkupGroup Deletes a specific markup group from the markup layer.
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IOSMarkupLayer::createMarkupGroup

Adds an empty markup group to the markup layer.

HRESULT createMarkupGroup([out] IOSMarkupGroup **ppMarkupGroup)

Parameters

[out] ppMarkupGroup—The new markup group interface

Description

After using this method to create an empty group for the markup layer, you 
add markup objects with the createMarkupObject method. Markup groups 
generally contain the markup objects created in a single update, as occurs in 
the Autodesk OnSite View user interface when a user taps the check mark 
(Done) button.

The ppMarkupGroup parameter returns a unique MarkupGroupID attribute, 
which is persistent in the OSM file.

See Also

IOSMarkupGroup::createMarkupObject on page 103

IOSMarkupLayer::removeAllGroups

Removes all markup groups from the layer.

HRESULT removeAllGroups()

Parameters

This method has no parameters.

Description

Deleting markup groups also deletes the markup objects they contain. If a 
markup group is selected when you remove the groups, calling this method 
triggers the onSelectionChanged event.

The removeAllGroups method always refreshes the map or drawing when 
the method is called from onViewChanging, onDrawingLoaded, or 
onMarkupLoaded event code. When called from the event code of other 
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event handlers, this method refreshes the drawing only if the AutoRefresh 
attribute is set to VARIANT_TRUE.

See Also

IOSAddIn::onSelectionChanged on page 66

IOSMarkupLayer::removeMarkupGroup on page 111

IOSMarkupLayer::removeMarkupGroup

Removes a markup group from the layer.

HRESULT removeMarkupGroup([in] IOSMarkupGroup *pMarkupGroup)

Parameters

[in] pMarkupGroup—The markup group to delete

Description

Deleting a markup group also clears the markup objects it contains. If the 
markup group is selected when you remove it, calling this method triggers 
the onSelectionChanged event.

The removeMarkupGroup method always refreshes the map or drawing 
when the method is called from onViewChanging, onDrawingLoaded, or 
onMarkupLoaded event code. When called from the event code of other 
event handlers, this method refreshes the drawing only if the AutoRefresh 
attribute is set to VARIANT_TRUE. 

See Also

IOSAddIn::onSelectionChanged on page 66

IOSMarkupLayer::removeAllGroups on page 110
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IOSMarkupObject Interface

The IOSMarkupObject interface represents a feature within a markup group 
on the markup layer, such as a Bézier curve, polyline, ellipse, leader, note, or 
symbol. You cannot publicly create instances of the IOSMarkupObject. Use 
methods of the IOSMarkupGroup interface for this purpose.

IOSMarkupObject Attributes

The following table summarizes the IOSMarkupObject attributes and a 
detailed description follows the table.

IOSMarkupObject Extent Attribute

The extent of the drawing feature, which is the smallest rectangle that 
includes the entire feature.

HRESULT getExtent([out] IOSExtent **ppExtent)

Parameters

[out] ppExtent—The extent interface

IOSMarkupObject MarkupGroup Attribute

The markup group containing the markup feature.

HRESULT getMarkupGroup([out] IOSMarkupGroup **ppMarkupGroup)

IOSMarkupObject 
Attribute 

Description Access

Extent The extent of the drawing feature. Read only

MarkupGroup The markup group containing the markup 
feature.

Read only

MarkupObjectID The unique ID of the markup feature. Read only

SelectedState The selection state of a markup feature. Read/Write

Type The type of the markup object. Read only
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Parameters

[out] ppMarkupGroup—A pointer to the parent markup group

IOSMarkupObject MarkupObjectID Attribute

The unique ID of the markup feature. This ID is persistent for a given OSM 
file.

HRESULT getMarkupObjectID([out] long *pMarkupID)

Parameters

[out] pMarkupObjectID—The identifier of the markup object, expressed as a 
32-bit integer

IOSMarkupObject SelectedState Attribute

The selection state of a markup feature.

HRESULT getSelectedState([out] VARIANT_BOOL *pSelectedState)

HRESULT setSelectedState([in] VARIANT_BOOL newSelectedState)

Parameters

[out] pSelectedState—The current selection state, either VARIANT_TRUE 
(selected) or VARIANT_FALSE (deselected)

[in] newSelectedState—The new selection state, either VARIANT_TRUE 
(selected) or VARIANT_FALSE (deselected)

Description

The setSelectedState method always refreshes the map or drawing when the 
method is called from onViewChanging, onDrawingLoaded, or 
onMarkupLoaded event code. When called from the event code of other 
event handlers, this method refreshes the drawing only if the AutoRefresh 
attribute is set to VARIANT_TRUE.

IOSMarkupObject Type Attribute

The type of the markup object.

HRESULT getType([out] OSMarkupObjectType *pType)



114 | Chapter 2 The Autodesk OnSite View COM API Object Reference

Parameters

[out] pType—The type of the markup object, such as note or polyline. For a 
list of values, see “Enumerated Data Types” on page 46.

See Also

OSMarkupObjectType in “Enumerated Data Types,” on page 46.

IOSMarkupObject Primitive Methods

The following table summarizes the IOSMarkupObject primitives and a 
detailed description follows the table.

Note You cannot create osBezier or osEllipse Markup objects by using the 
Autodesk OnSite View API.

IOSMarkupObject LeaderPrimitive

The text and geometry associated with a leader markup, which is a callout 
displayed on the user interface.

HRESULT getLeaderPrimitive([out] IOSPointCollection **ppVertices, 
[out] BSTR *pLeaderText)

HRESULT setLeaderPrimitive([in] IOSPointCollection *pVertices,  
[in] BSTR LeaderText

IOSMarkupObject 
Primitives 

Description Access

LeaderPrimitive The text and geometry associated with a 
leader markup object.

Read/Write

NotePrimitive The text annotation and vertex location of a 
note markup object.

Read/Write

PolylinePrimitive The collection and number of vertices that 
comprise a polyline.

Read/Write

SymbolPrimitive The symbol name and vertex location for a 
symbol markup object.

Read/Write
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Parameters

ppVertices and pVertices—A collection of points that define the callout 
placement

pLeaderText and LeaderText—The text displayed in the callout; returns a 
NULL BSTR * if the attribute is empty

Description

The setLeaderPrimitive method always refreshes the map or drawing when 
the method is called from onViewChanging, onDrawingLoaded, or 
onMarkupLoaded event code. When called from the event code of other 
event handlers, this method refreshes the drawing only if the AutoRefresh 
attribute is set to VARIANT_TRUE.

IOSMarkupObject NotePrimitive

The annotation and location of a note markup.

HRESULT getNotePrimitive([out] IOSPoint **pNoteVertex, [out] BSTR 
NoteText)

HRESULT setNotePrimitive([in] IOSPoint *pNoteVertex, [in] BSTR 
NoteText)

Parameters

pNoteVertex—The point that identifies the vertex of the note

NoteText—The text of the note; returns a NULL BSTR * if the attribute is 
empty

Description

The setNotePrimitive method always refreshes the map or drawing when the 
method is called from onViewChanging, onDrawingLoaded, or 
onMarkupLoaded event code. When called from the event code of other 
event handlers, this method refreshes the drawing only if the AutoRefresh 
attribute is set to VARIANT_TRUE.

IOSMarkupObject PolylinePrimitive

The collection of vertices that comprise a polyline.

HRESULT getPolylinePrimitive([out] IOSPointCollection **ppVertices)
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HRESULT setPolylinePrimitive([in] IOSPointCollection *pVertices)

Parameters

ppVertices and pVertices—A collection of points, each representing a vertex. 
The vertex positions are expressed in WCS units.

Description

The setPolylinePrimitive method always refreshes the map or drawing when 
the method is called from onViewChanging, onDrawingLoaded, or 
onMarkupLoaded event code. When called from the event code of other 
event handlers, this method refreshes the drawing only if the AutoRefresh 
attribute is set to VARIANT_TRUE.

IOSMarkupObject SymbolPrimitive

The location and name of a symbol markup object.

HRESULT getSymbolPrimitive ([out] IOSPoint **ppSymbolVertex, [out] 
BSTR *pSymbolName)

HRESULT setSymbolPrimitive([in] IOSPoint *pSymbolVertex, [in] BSTR 
SymbolName)

Parameters

ppSymbolVertex and pSymbolVertex—A point that represents the symbol 
location

pSymbolName and SymbolName—The name of the symbol. The symbol 
name is the name of its bitmap file, without the extension. This parameter 
returns a NULL BSTR * if the attribute is not set.

Description

Symbols are graphic files (.bmp) that produce a visual image on the user inter-
face. These images often suggest a physical object, such as office furniture or 
buildings. All symbol files are stored in the Symbols folder under the OnSite 
View folder on the mobile device.

The bitmaps for symbols must be 16- or 256-color bitmaps. The pixel color 
at the origin of the bitmap (0, 0) is used as the transparent color for painting 
the bitmap. The color red is remapped to indicate selection status.

The setSymbolPrimitive method always refreshes the map or drawing when 
the method is called from onViewChanging, onDrawingLoaded, or 
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onMarkupLoaded event code. When called from the event code of other 
event handlers, this method refreshes the drawing only if the AutoRefresh 
attribute is set to VARIANT_TRUE.
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IOSMarkupObjectCollection Interface

This collection facilitates operations that work with the set of markup objects 
in a markup group. You can examine and test the collection, but you cannot 
add or delete items directly. Use methods of the IOSMarkupGroup interface 
for this purpose.

IOSMarkupObjectCollection Attributes

The following table summarizes the IOSMarkupObjectCollection attribute 
and a detailed description follows the table.

IOSMarkupObjectCollection NumObjects Attribute

This attribute quantifies the number of markups in the collection.

HRESULT getNumObjects([out] long *pNumObjects)

Parameters

[out] pNumObjects—The number of markup interfaces that the collection 
contains

IOSMarkupObjectCollection Methods

The following table lists the IOSMarkupObjectCollection methods and a 
detailed description follows the table.

IOSMarkupObject
Attribute

Description Access

NumObjects The number of markups in the collection. Read only

IOSMarkupObjectCollection
Method

Description

isEmpty Tests the collection for the empty state.

item Gets an item from the collection.
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IOSMarkupObjectCollection::isEmpty

This method tests for an empty collection.

HRESULT isEmpty([out] VARIANT_BOOL *pIsEmpty)

Parameters

[out] pIsEmpty—The result of the test, either VARIANT_TRUE or 
VARIANT_FALSE

Description

If the collection contains one or more markups, the pIsEmpty parameter 
returns VARIANT_TRUE. Otherwise, it returns VARIANT_FALSE. 

You can also test for the empty condition by checking the NumObjects 
attribute. A collection is empty if the NumObjects attribute is zero. 

See Also

IOSMarkupObjectCollection NumObjects attribute on page 118

IOSMarkupObject on page 112

IOSMarkupObjectCollection::item

Gets an item from the collection.

HRESULT item([in] long Index, [out] IOSMarkupObject 
**ppMarkupObject)

Parameters

[in] Index—The location of the desired markup in the collection

[out] ppMarkupObject—The markup interface retrieved from the collection

Description

This method gets the markup at the specified index. Valid index values are 
zero to NumObjects minus one.

See Also

IOSMarkupObjectCollection NumObjects attribute on page 118
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IOSMarkupObject on page 112

IOSPoint Interface

A point represents a location on the drawing, such as the vertex of a polyline 
or location of a note. You can create points by using the createPoint method 
of the IOSApplication interface.

IOSPoint Attributes

The following table summarizes the IOSPoint attributes and a detailed 
description follows the table.

IOSPoint X Attribute

This attribute defines the X coordinate of a point.

HRESULT getX([out] double *pX)

HRESULT setX([in] double newX)

Parameters

[out] pX—The returned X value in WCS units, for example, 157003.00000

[in] newX—The new X value of the point, in WCS units

IOSPoint Y Attribute

This attribute defines the Y coordinate of a point.

HRESULT getY([out] double *pY)

HRESULT setY([in] double newY)

IOSPoint Attribute Description Access

X The X coordinate of the point. Read/Write

Y The Y coordinate of the point. Read/Write
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Parameters

[out] pY—The current Y value of the point in WCS units, for example, 
157003.00000

[in] newY—The new Y value of the point, in WCS units.

IOSPoint Method

The following table summarizes the IOSPoint method and a detailed descrip-
tion follows the table.

IOSPoint::equals

Compares this point to another point.

HRESULT equals([in] IOSPoint *pPoint,  [out] VARIANT_BOOL *pResult)

Parameters

[in] pPoint—The point interface for comparison with this IOSPoint

[out] pResult—VARIANT_TRUE if the two points are equivalent. Otherwise, 
it returns VARIANT_FALSE.

Description

This method compares points and considers them equal if are within a fixed 
tolerance of one another. This tolerance is dependent upon the drawing scale 
and cannot be viewed or changed. If you need to compare points by using a 
specific tolerance, create your own method to compare the X and Y attributes 
of IOSPoint. 

See Also

IOSPoint X attribute on page 120

IOSPoint Y attribute on page 120

IOSPoint Method Description

equals Compares point locations.
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IOSPointCollection Interface

The IOSPointCollection interface groups together points that belong to a 
single entity, such as the vertices of a polyline. You can create an 
IOSPointCollection by using the createPointCollection method of the 
IOSApplication interface.

IOSPointCollection Attribute

The following table summarizes the IOSPointCollection attribute and a 
detailed description follows the table.

IOSPointCollection NumObjects Attribute

This attribute quantifies the number of points in the collection.

HRESULT getNumObjects([out] long *pNumObjects)

Parameters

[out] pNumObjects—The number or points that the collection contains

IOSPointCollection Methods

The following table summarizes the IOSPointCollection methods and a 
detailed description follows the table.

IOSPointCollection
Attribute

Description Access

NumObjects The number of points in the collection. Read only

IOSPointCollection
Method

Description

isEmpty Tests for an empty collection.

add Adds a point to the collection.
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IOSPointCollection::isEmpty

Tests for an empty collection.

HRESULT isEmpty([out] VARIANT_BOOL *pIsEmpty)

Parameters

[out] pIsEmpty—The result of the test, either VARIANT_TRUE or 
VARIANT_FALSE

Description

If the collection contains one or more points, the pIsEmpty parameter 
returns VARIANT_TRUE. Otherwise, it returns VARIANT_FALSE. 

You can also test for the empty condition by checking the NumObjects 
attribute. A collection is empty if the NumObjects attribute is zero. 

See Also

IOSPointCollection NumObjects attribute on page 122

IOSPoint on page 120

IOSPointCollection::add

Adds a point to the collection.

HRESULT add([in] IOSPoint *pPoint, [out] long *pIndex)

Parameters

[in] pPoint—The point to add to the collection

[out] pIndex—The location of the new point in the collection

item Gets a point from the collection.

remove Removes a point from the collection.

removeAll Removes all points from the collection.

IOSPointCollection
Method

Description
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Description

This method adds a point to the collection and returns its location, specified 
as an index value. 

See Also

IOSPoint on page 120

IOSPointCollection::item on page 124

IOSPointCollection::remove on page 124

IOSPointCollection::item

Gets a point from the collection.

HRESULT item([in] long Index, [out] IOSPoint **ppPoint)

Parameters

[in] Index—The location of the desired point in the collection

[out] ppPoint—The point retrieved from the collection

Description

This method gets the point at the specified index.

See Also

IOSPoint on page 120

IOSPointCollection::add on page 123

IOSPointCollection::remove

Removes a point from the collection.

HRESULT remove([in] long Index)

Parameters

[in] Index—The location of the desired point in the collection
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Description

This method deletes the point at the specified index. 

See Also

IOSPoint on page 120

IOSPointCollection::add on page 123

IOSPointCollection::removeAll

Removes all points from the collection.

HRESULT removeAll()

Parameters

This method has no parameters.

Description

This method changes the collection to the empty state.

See Also

IOSPoint on page 120

IOSPointCollection::remove on page 124
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3Using the Inter-Application 
API

By using the Inter-Application API, Autodesk OnSite View 

can launch and control other mobile device applications. 

Conversely, you can launch Autodesk OnSite View from 

your application and display maps or drawings in a few 

steps. This chapter describes how to use the Inter-

Application API.

In this chapter

■ About the Inter-
Application API

■ Understanding the 
stack

■ Calling an application

■ Returning to the 
caller

■ Starting a compliant 
application

■ Opening an Autodesk 
OnSite View drawing

■ Cleaning up the stack
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About the Inter-Application API

By using the Inter-Application API, third-party applications can launch 
Autodesk OnSite View, open a drawing, and then resume operation. The API 
uses a generic stack that one application uses to call another and pass argu-
ments. Because the Inter-Application API is independent of the COM API, it’s 
compatible with most Windows CE applications.

Applications communicate with one another by using the inter-application 
stack. An application that implements the stack according to the rules of this 
chapter is called a compliant application. Autodesk OnSite View implements 
that part of the stack that permits calls by third-party applications.

In addition to complying with the stack protocol, compliant applications 
generally have a contract that defines what parameters they can exchange. 
For example, Autodesk OnSite View defines parameters for opening and 
displaying a map or drawing, which calling applications must supply.

This chapter starts with a general description of the stack, and then explains 
how to use the stack with Autodesk OnSite View.

Understanding the Stack

The stack is a catalog database of call and return records for compliant appli-
cations. All compliant applications read from and write to this single catalog.

Stack Storage

The stack uses the built-in database capabilities of Windows CE. The only 
limit to the depth of the stack is the inherent limitations of the database and 
physical resources.

Stack Structure

The stack consists of a series of records in a catalog database. The first record 
in the database is the number of entries in the stack, so this record is effec-
tively the stack pointer. This value should always be the number of launch 
records in the catalog, so it can be used to validate the stack.

Each record after the first is a launch record. The content of these records alter-
nates between parameters used for returning to the calling program and 
parameters for the called program. The last record is called the top-of-stack.
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The following table summarizes the stack structure for the case of one appli-
cation calling another.

Stack Record Syntax

A record on the call stack consists of four fields, separated by tab characters. 

“<program name>”<TAB><additional params><TAB><optional launch 
number><TAB><launch parameters>

The program name should include the path or be an accessible shortcut file. 
Program entries must be written to the stack in a UTF-8 String format, which 
allows language independence. Therefore, in your code, you need to trans-
late entries from ASCII to UTF-8 when writing to the stack and translate from 
UTF-8 to ASCII when reading from the stack. You can use the code in 
java.io.DataInputStream.readUTF and java.io.DataOutputStream.writeUTF as a 
model when writing C++ code.

The program name, tabs, and launch parameters are required, whereas the 
other program entry parameters are not. The following sections describe each 
of the parameters.

Program Name

The program name is the name of the application you are calling. The name 
you specify here must match the name you call from your code exactly. If you 
call an application from your code that does not match a program in the 
stack, the stack is destroyed. Program names can have spaces because a tab 
character separates fields.

Additional Parameters

These are additional parameters that the applications exchange. Autodesk 
OnSite View uses this field to specify the map or drawing to open.

Record Value

0 Stack pointer, 2 in this case.

1 Launch record containing return parameters.

2 Launch record containing parameters for the called program. This record 
is the top-of-stack.
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Optional Launch Number

Set the optional launch number to 0.

Launch Parameters

The launch parameters provide information about how to launch the 
program. For example, launch parameters could be in the CGI format as 
follows:

command?parameter=value&parameter=value

Calling an Application

This section explains how to call one application from another by using the 
Inter-Application API.

To call one application from another

1 Check that the stack database exists and open it. 

The following header fragment defines structures for the database and 
UInt.

// Header excerpt.
private:

typedef struct _CEDB {
   WCHAR *name;

HANDLE hFile;
BOOL isStore;
CEOID oDB;

} _CEDB;
typedef unsigned int UInt;

The following code fragment opens a database as specified by the name 
argument.

CIPCApp::_CEDB* CIPCApp::OpenDB()
{

#define RECORD_ID MAKELONG(CEVT_UI4, 0)

// Pointer to the _CEDB database.
    int size; // size of the _CEDB struct
    _CEDB *cedb; // pointer to the _CEDB database

// Create CEDB struct and clear.
size = sizeof(struct _CEDB);
cedb = (_CEDB *)malloc(size);
if (cedb == NULL) return NULL;

    memset(cedb, 0x00, size);
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// Allocate space for the name and copy name into struct.
LPWSTR dbName = _T("MauiStack");
cedb->name = (WCHAR *)malloc(2*(wcslen(dbName) + 1));
wcscpy((WCHAR *)cedb->name, dbName);

// Open a database
cedb->oDB = 0;
cedb->hFile = CeOpenDatabase(&cedb->oDB, dbName, RECORD_ID,

(DWORD)0, 0);
if (cedb->hFile == INVALID_HANDLE_VALUE) return NULL;

cedb->isStore = TRUE;
return cedb;

}

2 If there’s no stack, create one and open it. 

The following code fragment shows how to create a new database. Step 1 
shows how to open it.

bool CIPCApp::CreateStack()
{

#define NUMBER_OF_FIELDS_TO_SORT 1
CEOID dbOid;

// Define the stack name. Do not use a different name.
LPWSTR dbName = _T("MauiStack"); 
DWORD Catalog_CEDBTYPE = 1;
SORTORDERSPEC sort[NUMBER_OF_FIELDS_TO_SORT];

// Use this ordering to have records appended.
sort[0].propid = CEVT_UI4; // pos
sort[0].dwFlags = 0; // ascending
dbOid = CeCreateDatabase(dbName, Catalog_CEDBTYPE,

NUMBER_OF_FIELDS_TO_SORT, sort);

return dbOid == 0 ? FALSE : TRUE;
}

3 If the database is new, initialize the stack pointer.

The following code fragment creates a record for the stack pointer and ini-
tializes it to zero. 

bool CIPCApp::Add_NumberOf_Record(_CEDB *cedb)
{

#define NEW_RECORD 0 // The value for adding a new record.
const int numberOfStackEntries = 0;
CEOID oiRecord = NEW_RECORD;// Record (Create NEW) record
CEPROPVALprops[2]; // Record data
DWORD thisFieldSize = 1;// Size of stack size field
DWORD fieldSize; // Size of a field
CEBLOB blob; // For allocating stack size field
fieldSize = thisFieldSize;

// Make sure the database is valid.



132 | Chapter 3 Using the Inter-Application API

if (NULL == cedb) return FALSE;

// Prepare pos field
int kFIELD_POS = 0;
int kFIELD_DATA = 1;
props[kFIELD_POS].propid = CEVT_UI4;
props[kFIELD_POS].wFlags = 0;
props[kFIELD_POS].val.ulVal = (ULONG)0;

// Allocate blob to hold stack field
blob.lpb = (BYTE *)LocalAlloc(LMEM_FIXED, fieldSize);
if (blob.lpb == NULL) return FALSE;

props[kFIELD_DATA].propid = CEVT_BLOB;
props[kFIELD_DATA].wFlags = 0;
props[kFIELD_DATA].val.blob = blob;

// Initialize record to indicate no launch records.
props[kFIELD_DATA].val.blob.dwCount = fieldSize;
props[kFIELD_DATA].val.blob.lpb[0] = numberOfStackEntries;

static const int STACK_SIZE_RECORD_LENGTH = 2;

// Write the first record 
if ((oiRecord = CeWriteRecordProps(cedb->hFile, oiRecord,

STACK_SIZE_RECORD_LENGTH, props)) == 0) return FALSE;
return TRUE;

}

4 Push a launch record onto the stack corresponding to a return to this 
application. 

This is the record the other program uses to return to yours.

Note Pushing the launch record onto the stack means adding the record and 
incrementing the stack count.

The following code fragment adds a launch record to the stack database. 
The utflen parameter is the length of the launch record after converting it 
to UTF-8, and the newIndex parameter is the record position on the stack. 

You’ll update the stack pointer later.

bool CIPCApp::AddUTF8Record(_CEDB* cedb, char* newRecord,
UInt utflen, UInt newIndex)

{
const   intnumberOfStackEntries = 0;
CEOID oiRecord; // Record
CEPROPVAL props[2]; // Record Data

DWORD thisFieldSize = 1; // Size of stack size field
DWORD fieldSize; // Size of a field
CEBLOB blob; // For allocating stack size field
fieldSize = utflen;

//Test for a valid database;
if (NULL == cedb) return FALSE;
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// prepare pos field
int kFIELD_POS = 0;
int kFIELD_DATA = 1;

props[kFIELD_POS].propid = CEVT_UI4;
props[kFIELD_POS].wFlags = 0;
props[kFIELD_POS].val.ulVal = (ULONG)newIndex;

// allocate blob to hold stack field
blob.lpb = (BYTE *)LocalAlloc(LMEM_FIXED, fieldSize);
if (blob.lpb == NULL) return FALSE;

props[kFIELD_DATA].propid = CEVT_BLOB;
props[kFIELD_DATA].wFlags = 0;
props[kFIELD_DATA].val.blob = blob;

// populate record
props[kFIELD_DATA].val.blob.dwCount = fieldSize;
memcpy(props[kFIELD_DATA].val.blob.lpb, newRecord,

fieldSize);

static const int STACK_SIZE_RECORD_LENGTH = 2;

// update first record 
if ((oiRecord = CeWriteRecordProps(cedb->hFile, NEW_RECORD,

STACK_SIZE_RECORD_LENGTH, props)) == 0) return FALSE;

LocalFree(blob.lpb);
return TRUE;

}

5 Push a record containing the called application’s name, launch code, 
launch parameters, and possibly other information. For more informa-
tion, see “Calling Autodesk OnSite View” on page 137.

6 Update the stack pointer.

The following code fragment shows how to update the pointer value. Pass 
the database identifier and the count, which is 2 if you started with a new 
database.

bool CIPCApp::UpdateStackEntryCount(_CEDB* cedb, int count)
{

DWORD cbBuff; // Buffer to hold data size
unsigned short cProps; // Number of Properties in the record
CEOID oiRecord; // Record
CEPROPVAL *MyRecord = NULL; // Record Data

if ((oiRecord = CeSeekDatabase(cedb->hFile,
CEDB_SEEK_BEGINNING, 0, NULL)) == 0) return FALSE;

// Read the first record.
if ((oiRecord = CeReadRecordProps(cedb->hFile,

CEDB_ALLOWREALLOC, &cProps, NULL, (LPBYTE*)&MyRecord,
&cbBuff)) == 0) return FALSE;
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int kFIELD_DATA = 1;
MyRecord[kFIELD_DATA].val.blob.dwCount = 1;
MyRecord[kFIELD_DATA].val.blob.lpb[0] = count;

// Update the first record. 
if ((oiRecord = CeWriteRecordProps(cedb->hFile, oiRecord, 2,

MyRecord)) == 0) return FALSE;

return TRUE;
}

7 Make a system call to start the program being called. 

For example, the following code fragment makes a system call to launch 
the program specified by the command argument. 

int CIPCApp::RunApp(LPCWSTR* command, LPCWSTR* params)
{
    SHELLEXECUTEINFO sei;

memset(&sei, 0, sizeof(sei));

sei.cbSize = sizeof(sei);
sei.lpFile = command;
sei.lpParameters = params;
sei.nShow = SW_SHOWNORMAL;

if (ShellExecuteEx(&sei) != 0)
return 0;

else
return GetLastError();

}

When launching Autodesk OnSite View, the second argument, params, is 
a null string.

8 Quit.

The stack contains the following launch records when you make the system 
call.

Record Value

0 Stack pointer, 2 in this case.

1 Launch record containing return parameters.

2 Launch record containing parameters for the called program. This record 
is the top-of-stack.
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Returning to the Caller

When the called application finishes, it performs the following steps to 
initiate a return to the caller.

1 Pops the stack, removing the call to the currently running application.

Note Popping the stack means deleting the record and decrementing the 
stack count.

2 Reads the new record at the top of the stack that contains the name of the 
program to return to.

3 Appends a name/value string to the calling application’s return parameter 
list if the API contract requires a return value. 

4 Makes a system call to start the application that is to be returned to.

5 Quits.

The stack has the following launch record when you make the system call.

Record Value

0 Stack pointer, 1 in this case.

1 Launch record containing return parameters. This is the top-of-stack 
now.
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Starting a Compliant Application

When a compliant application starts, it must first check the stack and then 
respond accordingly. The following steps show the startup procedure.

Compliant application startup logic

1 The application starts and looks for the stack.

2 If the application finds the stack, it checks that it’s correctly formatted. 

3 If the stack is not valid, the application deletes the stack.

If the application does not find the stack, the application starts up any-
way, as if the user had started the application directly. The stack is needed 
only when the compliant application is called by another compliant 
application.

4 The application determines whether or not the record at the top of the 
stack is meant for the application. 

If the name of the application field in that record is the same as the appli-
cation name, the record is meant for the application. If the application 
finds that the field does not match, it deletes the stack, because the stack 
is invalid. 

5 The application determines whether it has been returned to from 
Autodesk OnSite View (or another compliant application) or it is being 
called by a compliant application. If the top-of-stack record has an odd 
index number, the record contains a return-to message. 

6 The application reads the record parameters and acts accordingly. For 
Autodesk OnSite View, it attempts to open a drawing.

7 If this is a return-to operation, the application pops the stack, then deletes 
the database if the stack is empty. For being-called operations, the appli-
cation waits for termination before popping the stack.
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Opening an Autodesk OnSite View Drawing

This section describes how to use the stack to open an Autodesk OnSite View 
map or drawing. Autodesk OnSite View uses the additional parameters field 
to specify which drawing to display.

Specifying Which Drawing to Display

For Autodesk OnSite View, you use the goToMapSet keyword and the 
drawing parameters in the following table to control which map or drawing 
appears when launching Autodesk OnSite. The following table describes 
each of the goToMapSet parameters.

Calling Autodesk OnSite View

When calling Autodesk OnSite View, first push your program onto the stack 
with calling parameters. These parameters indicate how to return to your 
program after Autodesk OnSite View is done.

Parameter Description

Mapset The path and name of the OSD or OSM file. This is a 
fully-qualified entry.

displayCenterX,
displayCenterY

The X and Y coordinates of the point to use as the 
center of the map. You must specify both parameters or 
neither one. Specifying either one without the other 
causes an error. If these parameters are not specified, 
the default value for the drawing is used.

zoomLevel A value from 0 to 9 indicating how many times to zoom 
in on the map before displaying it. If this parameter is 
not specified, the default value for the drawing is used.

Record Value

0 1

1 "\Program Files\MyFolder\MyApp"<TAB><TAB><TAB>
setUrl?URL=http://yourcompany.com&OtherParam=Y&AnotherParam=Z
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Record 0 indicates the number of entries on the stack, one in this case. 
Record 1 tells the called program how to return. This example returns a URL 
and some other parameters. The content of this record is specific to your 
application.

Next, push the name of the program being called, OnSite, onto the stack with 
parameters indicating the map or drawing file name and how you want to 
display it. At this point, you must update the first record in the stack so that 
it indicates the correct number of records.

Record 2 specifies OnSite as the program name. This example omits the 
launch number and launch parameters. For the additional parameters, it uses 
the goToMapSet keyword with parameters to indicate which map to open 
and how to display it. The display parameters are optional.

Finally, you make a system call (ShellExecuteEx) to start Autodesk OnSite View 
from your application. Autodesk OnSite View reads the program entry on the 
stack to determine which map or drawing to display. 

The user interface displays the sample drawing:

Record Value

0 2

1 "\Program Files\MyFolder\MyApp"<TAB><TAB><TAB>
setUrl?URL=http://yourcompany.com&OtherParam=Y&AnotherParam=Z

2 \Program Files\OnSite View\OnSiteView<TAB><TAB><TAB>
goToMapSet?MapSet=\My Documents\sample.osd
&displayCenterX=100&displayCenterY=100
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When the user closes Autodesk OnSite View, the Inter-Application API pops 
the Autodesk launch record from the stack, so that your application is now 
the top-of-stack, as shown here. 

Autodesk OnSite View then makes a system call to return to your application. 
When your application starts, it checks the stack for a record starting with its 
name. Since the stack pointer is an odd number and the launch record starts 
with MyApp, this is a return from a previous call. If the stack is empty, it is 
discarded.

Record Value

0 1

1 "\Program Files\MyFolder\MyApp"<TAB><TAB><TAB>
setUrl?URL=http://yourcompany.com&OtherParam=Y&AnotherParam=Z
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Cleaning Up the Stack

Before removing a launch record from the stack, detect whether your appli-
cation put itself on the stack or whether another application put it there. 

You can detect whether you need to remove your launch record from the 
stack by calculating whether there is an odd or even number of launch 
records on the stack. If there is an odd number of launch records, your appli-
cation put itself there. If there are an even number of launch records, another 
application put it there, because there is a program entry for your application 
and for the calling application. Thus, to clean up the stack safely, write code 
that executes whenever your application starts, counts the number of launch 
records in the stack, and if the number is odd, removes your launch record. 

The number of launch records is stored in the first record of the stack, and if 
a calling application did not update this record, the number is not accurate. 
To determine the number of launch records on the stack, count the records, 
and subtract one for the first record. The difference is the number of launch 
records in the stack.
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A
accessing objects 14
acronyms 5
ActiveMarkupGroup attribute 32, 108
add method

of IOSIntegerCollection 97
of IOSPointCollection 123

adding
COM components to project 7
custom symbols to markup layer 31
menu items to GUI 22

Application attribute 70
applications

calling 130–134
compliant 128, 136
starting 136

ATL, defined 5
attributes, using 15
Author attribute 33, 100
Autodesk Developer Network (ADN) 2
AutoRefresh attribute 37, 70

B
BaseDrawingFileName attribute 71
BaseDrawingSourceFileName attribute 71
bits, for HRESULT 15
breakpoints, setting and using 22

C
call stack, parameters in record of 130
calling applications, from Autodesk OnSite View 

130
calling Autodesk OnSite View, from applications 

137
capturing user input 3
CenterX and CenterY attributes 34, 72–73
checking visibility 30
cleaning up the stack 140
closeDrawing method 77
CLSID

defined 5
registering 10–12

collections, using 18
COM API

description of 2

object model and interfaces 44
COM components, adding to project 7
COM projects, creating 6
COM, defined 5
Comment attribute 101
compliant application 128
converting files

using the command-line for 41–42
coordinate system 38–40
CPU, conserving resources of 17
createIntegerCollection method 48
createMarkupGroup method 110
createMarkupObject method 103
createPoint method 48
createPointCollection method 49
creating COM projects 6
custom menus 22–26
custom symbols, adding to markup layer 31

D
data types 46
debugging add-ins 18–22
desktop setup 19
developer support 2
displayCenterX and displayCenterY parameters 

137
displaying drawings, using the Inter-Application 

API 137
Drawing attribute

of IOSApplication 47
of IOSDrawingLayer 83

drawing layers, hiding 28–30
DrawingLayer attribute 89
DrawingLayers attribute 73
DrawingObjects attribute 84
drawings, opening 26–28, 137–139
DWG, defined 5
DXF, defined 5

E
editing markups 4
enumerated data types 46
equals method 121
Extent attribute

of IOSDrawingLayer 84
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of IOSDrawingObject 90
of IOSMarkupObject 112

G
getCopyright method 52
getFirstMenuItem method 22–24, 52
getNextMenuItem method 22–24, 53
goToMapSet parameter 137–139
GPS application 40
guidelines, for programming 17–18

H
hiding layers 28
HRESULT, handling 15

I
IDE

defined 5
setting up 20–22

identifying objects 34
Inter-Application API, general description 128
IOSAddIn attributes and methods

ActiveMarkupGroup 32
getCopyright 52
getFirstMenuItem 22–24, 52
getNextMenuItem 22–24, 53
isMenuItemChecked 22–25, 54
isMenuItemEnabled 22–25, 54
onActivate 55
onAppKillFocus 55
onAppSetFocus 56
onBeginShutdown 56
onDrawingLoaded 37, 57
onDrawingObjectTapAndHold 34, 57
onDrawingUnloaded 58
onDrawingUnloading 58
onHibernate 58
onLoaded 59
onLoading 59
onMarkupGroupActive 32, 60
onMarkupGroupAdd 60
onMarkupGroupInactive 32, 61
onMarkupGroupModify 61
onMarkupGroupRemoving 62
onMarkupLoaded 37, 62
onMarkupLoading 63
onMarkupObjectAdd 63
onMarkupObjectModify 63
onMarkupObjectRemoving 64
onMarkupObjectTapAndHold 34, 64
onMarkupSaved 65
onMarkupSaving 65
onMarkupUnloaded 65

onMenuItemSelected 22, 25–26, 66
OnSelected 34
onSelectionChanged 33, 66
onUnloading 67
onViewChanged 67
onViewChanging 37, 68

IOSApplication attribute and methods
createIntegerCollection 48
createPoint 48
createPointCollection 49
Drawing 47

IOSDrawing attributes and methods
Application 70
AutoRefresh 37, 70
BaseDrawingFileName 71
BaseDrawingSourceFileName 71
CenterX 34, 72
CenterY 34, 73
closeDrawing 77
DrawingLayers 73
MarkupLayer 74
openFile 78
openFile method 26
Projection 39, 74
refresh 78
Scale 35
UnitConversionFactor 39, 74
ViewScale 75
ViewX 34, 75
ViewY 34, 76
zoomExtent 36, 79
zoomScale 36, 80
zoomSelected 36, 81

IOSDrawingLayer attributes
Drawing 83
DrawingObjects 84
Extent 84
MaxDisplayRange 35, 84
MinDisplayRange 35, 85
Name 85
NowDisplayed 85
VisibleState 28–30, 86

IOSDrawingLayerCollection attribute and 
methods

isEmpty 88
item 88
NumObjects 87

IOSDrawingObject attributes
DrawingLayer 89
Extent 90
key 90
Link 34, 90
Name 91
SelectedState 91

IOSDrawingObjectCollection attribute and 
methods

isEmpty 93
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item 93
NumObjects 92

IOSExtent attributes
MaxX and MaxY 94, 95
MinX 95
MinY 95

IOSIntegerCollection attributes and methods
add 97
isEmpty 97
item 98
NumObjects 96
remove 98
removeAll 99

IOSMarkupGroup attributes and methods
Author 33, 100
Comment 101
createMarkupObject 103
MarkupGroupID 101
MarkupLayer 101
MarkupObjects 101
removeAllObjects 104
removeMarkupObject 104
RevisedBy 33, 102
SelectedState 102
Status 33, 103

IOSMarkupGroupCollection attribute and 
methods

isEmpty 106
item 107
NumObjects 105

IOSMarkupLayer attributes and methods
ActiveMarkupGroup 108
createMarkupGroup 110
MarkupGroups 109
removeAllGroups 110
removeMarkupGroup 111

IOSMarkupObject attributes and primitive 
methods

Extent 112
LeaderPrimitive 114
MarkupGroup 112
MarkupObjectID 113
NotePrimitive 115
PolyPrimitive 115
SelectedState 113
setSymbolPrimitive 31
SymbolPrimitive method 116
Type 113

IOSMarkupObjectCollection attribute and 
methods

isEmpty 119
item 119
NumObjects 118

IOSPoint attributes and method
equals 121
X 120
Y 120

IOSPointCollection attribute and methods
add 123
isEmpty 123
item 124
NumObjects 122
remove 124
removeAll 125

isEmpty method
of IOSDrawingLayerCollection 88
of IOSDrawingObjectCollection 93
of IOSIntegerCollection 97
of IOSMarkupGroupCollection 106
of IOSMarkupObjectCollection 119
of IOSPointCollection 123

isMenuItemChecked method 22–25, 54
isMenuItemEnabled method 22–25, 54
item method

of IOSDrawingLayerCollection 88
of IOSDrawingObjectCollection 93
of IOSIntegerCollection 98
of IOSMarkupGroupCollection 107
of IOSMarkupObjectCollection 119
of IOSPointCollection 124

K
Key attribute 90
keys, for identifying objects 34

L
launch number and Launch parameters 129
layers, hiding 28
LeaderPrimitive method 114
Link attribute 34, 90
loading add-ins 13

M
Mapset parameter 137
markup objects, types of 46
MarkupGroup attribute 112
MarkupGroupID attribute 101
MarkupGroups attribute 109
MarkupLayer attribute

of IOSDrawing 74
of IOSMarkupGroup 101

MarkupObjectID attribute 113
MarkupObjects attribute 101
markups

editing 4
tracking changes to 33
working with 30–33

MaxDisplayRange attribute 35, 84
MaxX and MaxY attributes 94, 95
measurement units 38
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menu activation, responding to 25
menu items

adding to GUI 22
controlling 24–25

menus
customizing 22–25
responding to activation of 25

MFC, defined 5
MinDisplayRange attribute 35, 85
MinX and MinY attributes 95
mobile device setup 18
MWF, defined 5

N
Name attribute

of IOSDrawingLayer 85
of IOSDrawingObject 91

navigating drawings 14
NotePrimitive method 115
NowDisplayed attribute 85
NumObjects attribute

of IOSDrawingLayerCollection 87
of IOSDrawingObjectCollection 92
of IOSIntegerCollection 96
of IOSMarkupGroupCollection 105
of IOSMarkupObjectCollection 118
of IOSPointCollection 122

O
object identifiers 34
object model, for COM API 44
objects, accessing 14
OGC Well-known Text string 39
onActivate method 55
onAppKillFocus method 55
onAppSetFocus method 56
onBeginShutdown method 56
onDrawingLoaded method 37, 57
onDrawingObjectTapAndHold method 34, 57
onDrawingUnloaded method 58
onDrawingUnloading method 58
onHibernate method 58
onLoaded method 59
onLoading method 59
onMarkupGroupActive method 32, 60
onMarkupGroupAdd method 60
onMarkupGroupInactive method 32, 61
onMarkupGroupModify method 61
onMarkupGroupRemoving method 62
onMarkupLoaded method 37, 62
onMarkupLoading method 63
onMarkupObjectAdd method 63
onMarkupObjectModify method 63
onMarkupObjectRemoving method 64

onMarkupObjectTapAndHold method 34, 64
onMarkupSaved method 65
onMarkupSaving method 65
onMarkupUnLoaded method 65
onMenuItemSelected method 22, 25–26, 66
onSelected method 34
onSelectionChanged method 33, 66
onUnloading method 67
onViewChanged method 67
onViewChanging method 37, 68
openFile method 26, 78
opening drawings

using the COM API 26
using the Inter-Application API 137–139

OSD, defined 5
OSM, defined 5
OSMarkupGroupStatus 46
OSMarkupObjectType 46
OSVConvert command 41–42

P
panning, using the COM API 35
parsing projection strings 39
pointer usage 17
PolylinePrimitive method 115
primitive methods, of IOSMarkupObject 31, 114–

117
processing, minimizing 17
program entries, removing from stack 140
program name in the stack 129
Projection attribute 39, 74
projection string, parsing 39
projects, creating COM 6

R
records, formatting 129
refresh method 78
refreshing views 36–38
registering add-ins 10–12
remove method

of IOSIntegerCollection 98
of IOSPointCollection 124

removeAll method
of IOSIntegerCollection 99
of IOSPointCollection 125

removeAllGroups method 110
removeAllObjects method 104
removeMarkupGroup method 111
removeMarkupObject method 104
removing stack entries 140
requirements for creating add-ins 6
RevisedBy attribute 33, 102
RML, defined 5
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S
Scale attribute 35
SelectedState attribute

of IOSDrawingObject 91
of IOSMarkupGroup 102
of IOSMarkupObject 113

selections, identifying changes to 33–34
setSymbolPrimitive method 31
setting breakpoints 22
setting up the desktop, IDE, and mobile device 

18–22
shutting down an application 17
stack

cleaning up 140
understanding and using 128–129

starting applications, using the Inter-Application 
API 136

Status attribute 33, 103
status, types of markup group 33, 46
storing the stack 128
support, technical 2
SymbolPrimitive method 116
symbols, adding to markup layer 31

T
tap and hold, responding to 34
technical support 2
terminology 5
testing add-ins 12
toolbars. See menus
tracking changes to markups 33
training 2
Type attribute 113

U
UnitConversionFactor attribute 39, 74
units of measurement 38
user input

capturing 3
responding to 25

UTF-8 string format 129

V
view attributes 3
views, panning, zooming, refreshing 34–37
ViewScale attribute 75
ViewX and ViewY attributes 34, 75–76
visibility, checking 30
VisibleState attribute 28–30, 86
Visual C++ IDE 20

W
WCE, defined 6
WCS, defined 6
WKT, definition of string 6
Writing Add-In Code 13

X
X and Y attributes 120–121

Z
zoomExtent method 36, 79
zooming 36
zoomLevel parameter 137
zoomScale method 36, 80
zoomSelected method 36, 81
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